
CorelMOVE Help Contents

To select a category with the mouse, point to its icon then click. With the keyboard, press Tab to highlight the 
category you want then press ENTER. Help Topics for the Paint Editor and Wave Editor can be accessed by selecting 
the appropriate tab.



Click on the above graphic to get more information about a particular part of the CorelMOVE 
screen.



Commands
For help on a menu item, click on the appropriate menu, then click the menu item.



Tools

Pick Tool

Path Tool

Actor Icon

Prop Icon

Sound Icon

Cue Tool



How to...
View Animations
Create Animation Objects
Select Animation Objects
Move, Copy and Delete Animation Objects
Edit Animation Objects
Use the Cel Sequencer
Install the CorelMOVE MCI player driver



Keyboard

Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Technical Support

The Technical Support Help file contains information pertaining to:

· Corel Support Services
· Common Error Messages
· Printing Information
· Import and Export File Filter information
· INI files
· and other technical information

Since this information is constantly being updated the Technical Support help file is a 
separate help file. Please click on the highlighted text below to access the Technical Support 
Help file. 

Technical Support



CorelMOVE Paint Editor Help Contents

To select a category with the mouse, point to its icon then click. With the keyboard, press Tab to highlight the 
category you want then press ENTER. Help Topics for the Animation Window and Wave Editor can be accessed by 
selecting the appropriate tab.



Paint Edit Screen
Overview
Control Menu Box
Menu Bar
Painting Window
Scroll Bars
Title Bar
Toolbox
Window Border



Commands (Paint Editing)



Tools (Paint Editing)
Marquee Tool
Lasso Tool
Pencil Tool
Brush Tool
Bucket Tool
Spraycan Tool
Text Tool
Eraser Tool
Color Pick-up Tool
Line Tool
Rectangle Tool
Rounded Rectangle Tool
Oval Tool
Curve Tool
Polygon Tool
Pattern Selector
Foreground Color Selector
Background Color Selector
Line Width Selector
Recent Color Pick-up
Cel Counter
Move-to-Cel Scroll Bar



CorelMOVE Wave Editor Help Contents

To select a category with the mouse, point to its icon then click. With the keyboard, press Tab to highlight the 
category you want then press ENTER. Help Topics for the Animation Window and Paint Editor can be accessed by 
selecting the appropriate tab.



Wave Edit Screen
Overview
Control Menu Box
Editing Window
Play Button
Record Button
Scroll Bar
Status Bar
Stop Button
Title Bar
Window Border
Zoom Scroll Bar



Commands (Wave Editing)



Animation Screen Area
The Animation Screen Area is where the actual animation images such as actors and props are displayed
and animated. This is also the area where you can use the mouse to position placed actors or props in 
the current frame you are editing, or plot and edit path points for the actors.



 Control Menu Box
Located at the left end of the Title bar in the CorelMOVE animation and Help windows. Clicking on the 
Control Menu box displays commands for sizing and positioning the window. See Control Menu 
Commands.



Control Panel 

The Control Panel is located at the bottom of your screen. You can access most of the Roll-Ups in 
CorelMOVE by selecting the Timelines icon, the Library icon and the Cel Sequencer icon. As well, it has 
controls similar to those of a VCR which let you play and navigate through your animation.

Click on any part of the above graphic for more information.



Loop button 
The Loop button lets you play the animation over and over again in a continuous loop until you stop it. If it 
is Off, the animation plays once and stops on the last frame of the animation.



Current Frame number 
This field displays the number of the current frame.



Total Frame number 
This field displays the total number of frames.



Library button 
Clicking this button will display the Library Roll-Up.



Cel Sequencer button 
Clicking this button will display the Cel Sequencer Roll-Up.



Sound On/Off Toggle Button 
Click on this button to toggle the animation sound output On or Off.



Status Line 
The status line gives information on the currently selected object.



Enters At Frame 
This field shows the frame number in which the selected actor enters the animation.



Exits At Frame 
This field shows the frame number in which the selected actor exits the animation.



Frame Slider 
Click the frame slider to quickly jump to another frame in the animation.



Slider Button 
Click and drag this button to move to other frames of the animation. You could also use the slider bar to 
achieve the effect of Fast Forward Play and Fast Reverse Play by simply dragging the slider handle 
forward or backward at your desired speed.



Play Forward Button 
Click this button to play the animation.



Play Reverse Button 
Click this button to play the animation in reverse.



Stop Button 
Click this button to stop the animation.



Step Frame Forward Button 
Click this button to step the animation one frame forward.



Step Frame Reverse Button 
Click this button to step the animation one frame in reverse.



Rewind 
Click this button to go to the first frame of the animation.



Fast Forward 
Click this button to go to the last frame of the animation.



Show Timelines Button 
Click the Show Timelines button to display the Timelines Roll-Up.



Maximize/Restore Button  

Located in the upper right corner of the CorelMOVE and Help windows if they are not fully expanded. 
Clicking on the Maximize button expands the window to fill the entire screen. After you expand a window, 
the button changes to the Restore button. Use this button to return the window to its former size.

· You can also maximize a window by choosing Maximize from the Control menu.
· You can also restore a maximized window to its former size by choosing Restore 

from the Control menu.



Menu Bar 
The horizontal bar near the top of the window contains the names of the available pull-down menus. 
Choose the desired menu by clicking on it, or by pressing the ALT key plus the underlined character in the
menu name.



Minimize Button 
Located in the upper right corner of the CorelMOVE and Help windows. Clicking on the Minimize button 
shrinks the window to an icon at the bottom of the screen. After you expand a window, the button changes
to the Restore button. Use this button to return the window to its former size.

· As an icon, the application stays in memory, but its window does not take up space 
on your screen.

· To restore the window, double-click on its icon, or click once on the icon and choose 
Restore from the Control menu.



Restore Button 
Located in the upper right corner of the CorelMOVE and Help windows. Clicking on the Restore button 
returns the window to its previous size and location.

· You can also restore a window by choosing Restore from the Control menu.
· Using the Restore button does not affect a window moved or resized with the Move 

or Size commands in the Control menu.



Title Bar 
Located along the top of the top of a window, the Title Bar displays the name of the program and the file 
you are working on. If it is less than full-size, dragging the Title Bar moves the window.

The Title Bar may contain the following buttons for controlling the window:

 Maximize button

 Minimize button

 Restore button

 Control Menu box



Toolbox
Displayed on top of the CorelMOVE screen for quick access to the tools used to create, edit and view 
animations. Choose the tool you want information on from the list below.

Pick Tool

Path Tool

Actor Icon

Prop Icon

Sound Icon

Cue Tool



Window Border
Borders appear around windows that are less than full size. Dragging the border lets you make the 
window smaller or larger.

· Drag the top, bottom, or side border to size the window in one direction only.
· Drag the corner of the border to size the window vertically or horizontally.

With the window less than full size, you can also choose Size from the Control menu, then use the arrow 
keys to size the window.



Control Menu
Restore
Move
Size
Minimize
Maximize
Close
Switch To



Restore (Control Menu)
Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.

Clicking  in the upper-right corner of a maximized window is the same as choosing the Restore 
command.



Move (Control Menu)
Use this command to display a four-headed arrow so you can move the CorelMOVE window with arrow 
keys.

Note: This command is unavailable if you maximize the window



Size (Control Menu)
Use this command to display a four-headed arrow so you can size the CorelMOVE window with the arrow
keys.

Note: This command is unavailable if you maximize the window.



Minimize (Control Menu)
Use this command to reduce the CorelMOVE window to an icon.
Clicking in the upper-right corner of the window is the same as choosing the Minimize command.



Maximize (Control Menu)
Use this command to enlarge the CorelMOVE window to fill the available space.
Clicking in the upper-right corner of the window is the same as choosing the Maximize command.



Close (Control Menu)
Use this command to close the CorelMOVE window.

Double-clicking a Control Menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time. You can close all windows at once with the Close 
command on the File menu.



Switch To (Control Menu)
Use this command to display a list of all open applications. Use this Task List to switch to or close an 
application on the list.

Shortcut Key: Ctrl+Esc

Dialog Box Options

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.
Note: This option does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. Note: This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



File Menu
New

Open

Save

Save As

Import

Export

Mosaic Roll-Up

Color Manager

Preferences

Exit

1, 2, 3, 4



New... (File Menu) 

Choose New to create a new animation file.

Animations include objects such as actors, actors' paths, props, and sounds.
Each file, when created, will have a file extension of (.CMV).



Open... (File Menu) 

Choose Open to access an existing animation file folder.



Save (File Menu)

Saves the current animation under the name displayed in the Title bar. If you are altering an existing 
animation, but want to keep the original version, use the Save As command.

Shortcut
Pressing Ctrl+S saves current drawing.



Save As (File Menu) 

Choosing Save As opens the Save As dialog box which allows you to save the current animation under a 
new name. Also used to save an animation in a different directory.



Import (File Menu)
Import Actor from Animation File
Import Actor from Bitmap File(s)
Import Prop
Import Sound



Import Actor from Animation File (File Menu)
Choose Import Actor from Animation File to open the Import Actor dialog box which allows you to create 
an actor from animation files.



Import Actor from Bitmap File(s) (File Menu)
Choose Import Actor from Bitmap File(s) to open the Import Actor from Bitmap File(s) dialog box which 
allows you to create an actor from animation files.



Import Prop (File Menu)
Choose Import Prop to open the Import Prop dialog box which allows you to create an actor from 
animation files.



Import Sound (File Menu)
Choose Import Sound to open the Import Sound dialog box which allows you to create an actor from 
animation files.



Import movie files for actors
Movie files
CorelMOVE (*.CMV)
QuickTime for Windows (*.MOV)
MPEG Movie (*.MPG)
Motion Works (*.MWF)
Macintosh PICS Animation (*.PCS)
Macintosh PICT images (*.PCT)



Import bitmap files for actors
Movie files
Windows (*.BMP)
Compuserve (*.GIF)
JPEG (*.JPG)
Kodak PhotoCD (*.PCD)
Paintbrush (*.PCX)
Targa (*.TGA)
TIFF (*.TIF)



Import files for props
Movie files
CorelMOVE (*.CMV)
Motion Works (*.MWF)
Windows (*.BMP)
Compuserve (*.GIF)
JPEG (*.JPG)
Kodak PhotoCD (*.PCD)
Paintbrush (*.PCX)
Targa (*.TGA)
TIFF (*.TIF)



Import files for sounds
Movie files
AIFF Audio (*.AIF)
Video for Windows (*.AVI)
CorelMOVE (*.CMV)
QuickTime for Windows (*.MOV)
Motion Works (*.MWF)
Mac SND binary (*.SND)
Amiga SVX Audio (*.SVX)
SoundBlaster Audio (*.VOC)
Windows Sound File (*.WAV)



Export (File Menu)
Export To Movie
Export To Individual Files
Export To Sound



Export To Movie (File Menu)
Choosing Export To Movie opens the Export To Movie dialog box which allows you to save the current 
animation as a movie file.



Export To Individual Files (File Menu)
Choosing Export To Individual Files opens the Export To Individual File(s) dialog box which allows you to 
save the current animation as several individual bitmap files.



Export To Sound (File Menu)
Choosing Export To Sound opens the Export To Sound dialog box which allows you to save the sounds 
from the current animation as an audio file.



Exported movie files
Movie files
Video for Windows (*.AVI)
QuickTime for Windows (*.MOV)
MPEG Movie (*.MPG)
PICS Animation (*.PCS)
Macintosh PICT images (*.PCT)



Audio files
AIFF Audio (*.AIF)
Mac Sound (MacBinary) (*.MB2)
Amiga SVX Audio (*.SVX)
SoundBlaster Audio (*.VOC)
Windows Sound File (*.WAV)



Exported individual file formats
Windows Bitmap (*.BMP)
OS/2 Bitmap (*.BMP)
Compuserve Bitmap (*.GIF)
JPEG Bitmap (*.JPG, *.JFF, *.JTF, *.CMP))
CorelPHOTO-PAINT! (*.PCX)
TIFF 6.0 Four Color Bitmap (*.SEP)
Targa Bitmap (*.TGA, *.VDA, *.ICB, *.VST))
TIFF 5.0 Bitmap (*.TIF)



Mosaic Roll-Up (File Menu)
Displays the Mosaic file management utility as a Roll-Up window. It allows you to drag and 
drop files in your current CorelMOVE document.



Color Manager... (File Menu)

Color Manager calibrates color reproduction across your monitor, printer and scanners by building a 
System Color Profile. Your monitor, scanner, and printer are all profiled to more accurately display color 
results across the different devices.

Note: The defaults built into the Color Manager are pre-tested settings; use them whenever possible.

Dialog Box Options

Current Profile

Displays the name of the current color profile. If you have different printers you may wish to build 
different color profiles and then select the appropriate profile before working on drawings for that 
output device.

Notes

Allows you to attach notes to your system profile. Useful for keeping track of different equipment 
setups.

Monitor

Displays monitor choices. See monitor calibration below.

Printer

Displays printer choices. See printer calibration below.

Scanner

Displays scanner choices. See scanner calibration below.

Photographic

Enables system setup for working with Photographs.

Illustration

Enables system setup for working with vector-based illustrations.

Monitor Calibration

 Allows you to calibrate your monitor to enhance color accuracy.

Monitor Defines the gamma settings, as you increase the gamma level you are increasing 
the brightness of your midtone grey 

Characteristics: levels. Chromaticity defines hue and saturation or chroma. Its important to use the 
manufacturer recommended levels of chromaticity for your monitor. If you do not 
have manufacturer recommended levels and wish to modify gamma or chromaticity
settings use the Interactive Monitor Calibration.

White Point Defines the color temperature of your monitor in creating white.

Reset Returns the gamma and chromaticity values to default.

Interactive Interactive calibration lets the user adjust gamma and chromaticity interactively. 
Adjust the color fields to enhance color 

Calibration accuracy. Chromaticity should be set to the manufacturer's specifications. Gamma 



or brightness is variable according to the level of light in the room and the 
brightness and contrast controls on your monitor. This setting can be adapted by 
the user. 

Printer Calibration

 Allows you to calibrate your printer to enhance color accuracy.

Printer Type Defines whether the printer prints in four-colours (CMYK) or three (RGB).

UCR Enable Film or Printer depending on the output device being configured. TAC (Total
Ink Coverage) adjusts the level of UCR. See your printer for the appropriate level of
UCR, depending on paper stock and printer used.

Black Point Defines the apparent darkness of the black. A higher level means darker CMYK 
shadows. A lower level means lighter shadows.

Reset Returns the black point value to default.

Ink model field This field defines the ink model for the selected printer.

Color Match This dialogue box allows you to match your printer and your monitor color 
accuracy.

File Allows you to generate a test TIFF file to be measured to create
a new RHN file. 

Visual Enable Visual to match the colors of your printer visually to a 
printed test file.

Scanner Calibration

 Allows the user to calibrate the color accuracy of the systems scanner.

Shortcut
Pressing ALT+F,C opens the System Color Profile dialogue box.



Preferences (File Menu)
Choosing Preferences opens the Preferences dialog box which allows you to set the playback options of 
your animation and the default settings for new animations.



Exit (File Menu) 

Choosing Exit from the File menu closes CorelMOVE. If you have made any changes to the current file 
folder or opened animation, CorelMOVE will automatically prompt you to save them before closing down.



1, 2, 3, 4 (File Menu)
The names located next to these numbers are the last four animation files that were closed by 
CorelMOVE. Typing the number or clicking on one of the file names will open the animation, provided it 
was not moved or deleted from the directory in which CorelMOVE last saved it.



Edit Menu
Cut

Copy

Copy Frame

Paste

Delete

Duplicate

Clone

Select All

Insert Object

Object

Object Info

Animation Info...



Cut (Edit Menu) 

Removes the selected actor(s) or prop(s) from the current animation and places it onto the Clipboard. 
Once on the Clipboard, you can paste it as an actor or prop onto other frames or into another CorelMOVE
file.

· Objects cut from another CorelMOVE file are pasted into the current animation at 
the same size as the original.

· To permanently remove the selected object(s), use the Edit Delete command.

Shortcut
Press Ctrl+X



Copy (Edit Menu) 

Places a copy of the selected actor(s) or prop(s) onto the Clipboard. Once on the Clipboard, you can 
paste it as an actor or prop onto other frames or into another CorelMOVE file.

· Objects copied from another CorelMOVE file are pasted into the current animation at
the same size as the original.

Shortcut
Press Ctrl+C.



Copy Frame (Edit Menu)
Places a copy of the current frame (all visible actors and props) onto the Clipboard. Once on the 
Clipboard, you can paste it as an actor or prop onto other frames or into another CorelMOVE file.

· A frame copied from another CorelMOVE file is pasted into the current animation at 
the same size as the original.



Paste (Edit Menu) 

Places a copy of the object(s) currently on the Clipboard into your animation as an actor, prop, or sound. 
The original remains on the Clipboard until you copy or cut another object or end the current Windows 
session.
See also Paste Actor, Paste Prop and Paste Sound.

· Objects cut/copied from another CorelMOVE file are pasted into the current drawing 
at the same size as the original.



Paste Actor (Edit Menu) 

Places a copy of the object(s) currently on the Clipboard into your animation as an actor. The original 
remains on the Clipboard until you copy or cut another object or end the current Windows session.

· Objects cut/copied from another CorelMOVE file are pasted into the current drawing 
at the same size as the original.



Paste Prop (Edit Menu) 

Places a copy of the object(s) currently on the Clipboard into your animation as a prop. The original 
remains on the Clipboard until you copy or cut another object or end the current Windows session.

· Objects cut/copied from another CorelMOVE file are pasted into the current drawing 
at the same size as the original.



Paste Sound (Edit Menu) 

Places a copy of the sound(s) currently on the Clipboard into your animation. The original sound(s) 
remains on the Clipboard until you copy or cut another object or end the current Windows session.



Delete (Edit Menu) 

Deletes the selected object(s). A deleted object cannot be restored.

Shortcut
Press the DEL key.



Duplicate (Edit Menu) 

Adds a copy of the selected object(s) to the current animation.

· The copy is placed on top of the original and offset down and to the right. It is also 
selected automatically.

Shortcut
Press Ctrl+D



Clone (Edit Menu)
Copies the selected object and offsets the copy from the original. Most changes applied to the original 
object (called the master) are automatically applied to the copy (called the clone). For example, if you 
change the masters fill, the clone's fill will change as well. The reverse is also true, changes made to a 
clone will be applied to the master and all its clones.



Select All (Edit Menu)
Selects every object in your animation, including any not currently in view. Once the objects are selected, 
you can apply any command or operation to them.



Insert Object (Edit Menu) 

Inserts a new object into the current animation. See also: Insert New Object Actor, Insert New Object 
Prop or Insert New Object Sound.



Insert Object Actor (Edit Menu) 

Inserts a new actor into the current animation.

Shortcut
Press 



Insert Object Prop (Edit Menu) 

Inserts a new prop into the current animation.

Shortcut
Press 



Insert Object Sound (Edit Menu) 

Inserts a new sound into the current animation.

Shortcut
Press 



Object... (Edit Menu)
Opens the appropriate editing window and loads the selected object.

Shortcut
Press the Ctrl key and double-click on the object.



Object Info... (Edit Menu)
Opens an information dialog box which allows you to modify the selected object.



Animation Info... (Edit Menu)
Choose this menu option to display the Animation Information dialog box. This dialog box displays the 
number of actors, props, sounds and cues. It also allows you to set the animation's window size, number 
of frames, thumbnail frame, speed, and grid size.

Shortcut
Press Ctrl+A



View Menu
Timelines Roll-Up
Cel Sequencer Roll-Up
Library Roll-Up
Control Panel
Toolbox
Color Correction
Frame
Play
Stop



Timelines Roll-Up (View Menu)
Choose this menu option to display the Timelines Roll-Up. Timelines provide a dynamic view of all the 
objects within the animation. An object's information can be accessed and manipulated from within the 
Timelines Roll-Up.



Cel Sequencer Roll-Up (View Menu) 

Choose this menu option to display the Cel Sequencer Roll-Up. The Cel Sequencer Roll-Up is used to set
which cel of an actor is shown on each frame, as well as adjust its size.
To display the Cel Sequencer Roll-Up, click on an actor with the Pick or Path tool and then choose the Cel

Sequencer Roll-Up option under the View menu or click on the Cel Sequencer icon  in the Control 
Panel.



Library Roll-Up (View Menu) 

Choose this menu option to display the Library Roll-Up. Libraries are used to store and retrieve objects 
that can be placed in current or future CorelMOVE animations. Using the Library Roll-Up to place actors, 
props or sounds is faster and easier than importing.
To display the Library Roll-Up, choose the Library Roll-Up option under the View menu or click on the 

Library icon  in the Control Panel.



Control Panel (View Menu)
Choose this menu option to display the Control Panel. The Control Panel is located at the bottom of your 
screen.



Toolbox Visible/Floating (View Menu)
Lets you specify whether the toolbox is visible and if the toolbox is visible, whether it is floating. When the 
toolbox is floating, you can reposition it by clicking and dragging the rectangular area to the right of its 
control menu box.



Color Correction (View Menu)
This command allows you to increase the accuracy of your screen colors based on settings in the System
Color Profile dialog box.



Frame command (View Menu)
First Frame

Last Frame

Previous Frame

Next Frame

Specific



First Frame (View Menu) 

Choose First Frame to go to the first frame in the current animation. If you are already on the first frame, 
choosing First Frame does nothing.

Shortcut
Press Shift+F5



Last Frame (View Menu) 

Choose Last Frame to go to the last frame in the current animation. If you are already on the last frame, 
choosing Last Frame does nothing.

Shortcut
Press Shift+F6



Previous Frame (View Menu) 

Choose Previous Frame to go to the previous frame in the current animation. If you are at the first frame, 
choosing Previous Frame takes you to the last frame in the animation.

Shortcut
Press Shift+F7



Next Frame (View Menu) 

Choose Next Frame to go to the next frame in the current animation. If you are at the last frame in the 
animation, choosing Next Frame takes you to the first frame in the animation.

Shortcut
Press Shift+F8



Specific (View Menu) 

Choosing Go to Frame displays the Move to Frame dialog box. Use this dialog box to go directly to a 
specific frame in the currently loaded animation.



Play (View Menu) 

Starts the animation playing from the current frame.

Shortcut
Press F9



Stop (View Menu) 

Stops the animation.

Shortcut
Press Esc



Arrange Menu
To Front
To Back
Forward One
Back One



To Front
Select an actor or prop object, then click this menu item to move the object to the front of the appropriate 
layer.

Shortcut
Press Shift+PgUp



To Back
Select an actor or prop object, then click this menu item to move the object to the back of the appropriate 
layer.

Shortcut
Press Shift+PgDn



Forward One
Select an actor or prop object, then click this menu item. You would want to move an object closer when a
second object is covering it, not allowing you to select the object. You can also use this command to move
an object to a desired position in the layer. Keep using the command until the object is in the layer that 
you want. If the object is in the top of the layer, the command has no effect.

Shortcut
Press Ctrl+PgUp



Back One
Select an actor or prop object, then click this menu item, to move the object back one position in the 
appropriate layer. You would want to move an object further back when it's covering a second object, not 
allowing you to select the object. You can also use this command to move an object to a desired position 
in the layer. Keep using the command until the object is in the layer that you want. If the object is in the 
furthest position in the layer, the command has no effect.

Shortcut
Press Ctrl+PgDn



Help Menu
Contents

Screen/Menu Help

Search for Help On

QuickTour

About CorelMOVE



Help Menu
Contents

Screen/Menu Help

Search for Help On

QuickTour

About CorelMOVE



Contents (Help Menu)
Displays the opening Help screen for the current window. From this screen, you can choose the type of 
Help you want. When you are in Help, clicking on the Contents button takes you back to the opening 
screen.

Shortcut
Pressing F1 displays the Help Contents, or a Help topic on the selected command or open 
dialog box.



Screen/Menu Help (Help Menu)
Changes the mouse pointer to an arrow with a question mark. You can then click on an available menu 
command or a part of the screen (for example, a tool in the toolbox) to get Help about that item. You can 
also press a function key or key combination such as Ctrl+N to get Help about the command or tool 
associated with it.

NOTE: To get Help on unavailable (gray) commands, select the command and press F1.

Shortcut
Pressing SHIFT+F1 displays the Help pointer.



Search for Help On (Help Menu)
Displays the Help Search dialog box where you enter keywords to search for a specific Help topic. The 
Search dialog box can also be opened by choosing the Search button from the Help window.

Shortcut
Pressing Ctrl+F1 displays the Search dialog box.



QuickTour (Help Menu)
Opens the Corel QuickTour. This menu item is only available if the Corel QuickTour has been installed 
from the Corel CD #2.



About CorelMOVE (Help Menu)
Displays a dialog box with information about which version of CorelMOVE you are running. This 
command is not available in the Paint Edit or Wave Edit windows.



Pick Tool

 The Pick tool (also known as the Pointer tool) is used to select objects and allows you to move and 
manipulate placed actors and props. You can further manipulate them using various dialog boxes.

To open the Actor Information dialog box, double-click a placed actor or choose Object Info from the Edit 
Menu with an actor selected. Use this dialog to view or change an actor's information. You can view or 
change a prop's information in a similar way.



Path Tool

 Use the Path tool to add, create, or change points on an actor's path.

To create a path for an actor:

1. Click the Path tool icon.
2. Select an actor. If not already visible, the Path Edit Roll-Up opens.
3. Click new points for the path of action or drag the mouse with the SHIFT key held down to rapidly add 

points to the actor's path.



Place Actor Button

 Click the Place Actor button to place a new actor starting on the current frame in the animation. When 
you click this button the New Actor dialog box appears, allowing you to select an actor source.



Place Prop Button

 Click the Place Prop button to place new prop starting on the current frame in the animation. When you 
click this button the New Prop dialog box appears, allowing you to select a prop source.



Add Sound Button

 Click the Add Sound button to add a sound to the animation. When you click this button the New Wave 
dialog box appears, allowing you to select a wave source.



Add Cue Button

 Click the Add Cue button to add a new Cue to the animation. The Cue information dialog box appears, 
allowing you to enter a cue name, conditions, and commands.



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.

End or Ctrl+Right Arrow Moves to the end of a field.

Home or Ctrl+Left Arrow Moves to the beginning of a field.

PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).

SHIFT+TAB Moves from field to field in reverse order.

ALT+letter Moves to the option or group whose underlined letter matches the one 
you type.

DIRECTION key Moves from option to option within a group of options.

ENTER Executes a command button.
Or, chooses the selected item in a list box and executes the command.

Esc Closes a dialog box without completing the command. (Same as Cancel)

ALT+DOWN ARROW Opens a drop-down list box.

ALT+UP or DOWN ARROW Selects item in a drop-down list box.

SPACEBAR Cancels a selection in a list box.
Selects or clears a check box.

Ctrl+SLASH Selects all the items in a list box.

Ctrl+BACKSLASH Cancels all selections except the current selection.

SHIFT+DIRECTION key Extends selection in a text box.

SHIFT+HOME Extends selection to first character in a text box.

SHIFT+END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.

Or, deletes selected text.

Delete Deletes the character to the right of the cursor.

Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the Help 
window is already open, pressing F1 displays the Using Windows Help 
topics.

In some Windows applications, pressing F1 displays a Help topic on the 
selected command, dialog box option, or system message.

SHIFT+F1 Changes the pointer to  so that you can get Help on a specific 
command, screen region, or key. You can then choose a command, click 
the screen region, or press a key or key combination you want to know 
more about.



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.

Letter key Choose the menu, or menu item, whose underlined letter matches the 
one you type.

Alt+letter key Pulls down the menu whose underlined letter matches the one you type.

LEFT or RIGHT ARROW Moves among menus.

UP or DOWN ARROW Moves among menu items.

Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are using.

Key(s) Function

Ctrl+Esc Switches to the Task List.

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs.

Alt+TAB Switches to the next application window, restoring applications that are 
running as icons.

Alt+PrtSc Copies the entire screen to Clipboard.

Ctrl+F4 Closes the active window.

F1 Gets Help and displays the Help Index for the application. (See Help 
Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text to the left or right one character at a time.

SHIFT+DOWN or UP Selects one line of text up or down.

SHIFT+END Selects text to the end of the line.

SHIFT+HOME Selects text to the beginning of the line.

SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is already
selected.

SHIFT+PAGE UP Selects text up one window.

Or, cancels the selection if the previous window is 
already selected.

Ctrl+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.

Ctrl+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or end 
(DOWN ARROW) of the paragraph.

Ctrl+SHIFT+END Selects text to the end of the document.

Ctrl+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.

ALT+Hyphen Opens the Control menu for a document window.

Alt+F4 Closes a window.

Alt+Esc Switches to the next application window or minimized icon, including full-
screen programs.

Alt+TAB Switches to the next application window, restoring applications that are 
running as icons.

Alt+ENTER Switches a non-Windows application between running in a window and 
running full screen.

DIRECTION key Moves a window when you have chosen Move from the Control menu.
Or, changes the size of a window when you have chosen Size from the 
Control menu.



Command Line Options (CORELMOV.EXE)

CORELMOV.EXE [<Filename> ] [<p+|p->] [<l+|l->] [<s+|s->]

<Filename> Specify a filename with the file extension of .CMV

p+ Specify to CORELMOV.EXE to play the animation in a forward direction. The + is optional.
p- Specify to CORELMOV.EXE to play the animation in a reverse direction.
l+ Specify to CORELMOV.EXE to turn the Loop Animation option to ON.
l- Specify to CORELMOV.EXE to turn the Loop Animation option to OFF.
s+ Specify to CORELMOV.EXE to turn the Sound Enable option to ON.
s- Specify to CORELMOV.EXE to turn the Loop Animation option to OFF.

Note: The above command line options are case sensitive. They also override the equivalent animation 
options that are stored within the animation itself.

Examples:

CORELMOV.EXE Sample.cmv p+ s+ l+
or

CORELMOV.EXE Sample.cmv
or

CORELMOV.EXE s-



Overview of Paint Edit Screen
There are basically two parts to the Paint Edit screen:

1) The Paint Toolbox
The Paint Toolbox, also called the Paint Tool Palette, consists such frequently used paint
tools as pencils, brushes, spray tools, fill tools, lines and shapes drawing tools, as well 
as palettes for selecting foreground and background colors. The Paint Toolbox is the 
detached or floating window that comes up when you first start the Paint Editor.

2) The Paint Editor
The Paint Editor is the canvas or window in which the image of an actor or prop is 
actually drawn on. The Paint Editor operates in conjunction with the floating Paint 
Toolbox as well as with its own set of menu options. The menus in the Paint Editor itself
provide you with the means to save actors that have just been created or modified. 
You can cut and paste graphics, edit and manipulate graphics with various operations 
such as flip, invert, rotation, scaling, tinting and anti-aliasing.



 Control Menu Box (Paint Edit Window)
Located at the left end of the Title bar in the paint editing window. Clicking on the Control Menu box 
displays commands for sizing and positioning the window. See the Control Menu.



Painting Window

The Painting window is the canvas or window on which the image of an actor or prop is actually drawn, or
the area where bitmap graphics are altered and manipulated. Within the painting window, you can cut and
paste graphics, edit in fatbits mode and manipulate graphic images with various operations such as flip, 
invert, rotation, scaling, tinting and anti-aliasing.



Status Line
The Status line gives the horizontal (x) and vertical (y) coordinates of the cursor in pixels. If an object with 
a bounding box is being created, then the status line displays information about the height and width of 
the object. If a marquee selection is being made, then the dimensions of the marquee box are displayed.



Menu Bar 
The horizontal bar near the top of the window contains the names of the available menus. Choose the 
desired menu by clicking on it, or by pressing the ALT key plus the underlined character in the menu 
name.



Scroll Bars
Bars along the bottom and right side of the screen used to view portions of a drawing outside the current 
viewing area.

Click on the arrows to move the current view 10% in selected direction.
Click on an elevator to move the view by one full window.
Drag a thumb to move the view an arbitrary amount in any direction.



Title Bar
Located along the top of a window, the Title Bar displays the word Actor: or Prop: followed by the name 
of the object you are working on. Dragging the Title Bar moves the window.

The Title Bar may contain the following buttons for controlling the window:

 Control Menu box



Toolbox

The Paint Toolbox, also called the Paint Tool Palette, consists of a palette of paint tools such as pencils, 
brushes, spray tools, fill tools, lines and shapes drawing tools, as well as palettes for selecting foreground
and background colors. The Paint Toolbox is the detached or floating window that opens when you first 
start the Paint Editor. It has the title caption Tools marked on it. Click on the adjacent graphic to get more 
information on the tools.



Window Border
Borders appear around windows that are less than full size. Dragging the border lets you make the 
window smaller or larger.

· Drag the top, bottom, or side border to size the window in one direction only.

· Drag the corner of the border to size the window vertically or horizontally.

With the window less than full size, you can also choose Size from the Control menu, then use the arrow 
keys to size the window.



Move (Control Menu of Paint Edit Window)
Use this command to display a four-headed arrow so you can move the CorelMOVE window with the 
arrow keys.



Size (Control Menu of Paint Edit Window)
Use this command to display a four-headed arrow so you can size the Paint Edit window with the arrow 
keys.



Close (Control Menu of Paint Edit Window)
Use this command to close the Paint Edit window.

Double-clicking a Control-menu box is the same as choosing the Close command.



Switch To (Control Menu of Paint Edit Window)
Use this command to display a list of all open applications. Use this Task List 
to switch to or close an application on the list.

Shortcut
Keys: Ctrl+Esc

Dialog Box Options
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar. 
Note: This option does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. Note: This option does 
not affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Apply Changes (File Menu of Paint Edit Window)
Choosing Apply Changes will update the appearance of actors and props on stage to reflect any 
changes made in the Paint Edit window.



Exit (File Menu of Paint Edit Window)
Choosing Exit from the file menu closes the Paint Edit Window. If there are any changes to the current 
object, CorelMOVE will automatically prompt you to Apply Changes before closing the editing window.



Page setup (File Menu of Paint Edit Window)
The Page setup command opens the Set Size dialog box which is used to modify the horizontal and 
vertical dimensions of the prop or actor cels.



Undo (Edit Menu of Paint Edit Window)
Returns your object to the state it was in before you performed the last operation. Use Undo immediately 
after making a change you do not want implemented.

You cannot Undo the following operations:

· Any change of view (Zoom-in, Zoom-out, etc.)
· Any file operations (Apply Changes, Page Setup)
· Any special effects that modify all actor cels (Anti-Alias all cels, Tint all cels, etc.)
· Any selection of colors, patterns or fonts.

Shortcut
Press Ctrl+Z



Keep Paint (Edit Menu of Paint Edit Window)
Choose Keep Paint to commit your drawing to the current state, so that the Revert Paint command will 
only revert to this point and not before.



Revert Paint (Edit Menu of Paint Edit Window)
Choose Revert Paint to undo your graphic to either the file state or to the last committed state using the 
Keep Paint command.



Cut (Edit Menu of Paint Edit Window)
Removes the graphic selected with either the Lasso or Marquee tool from the current drawing and places 
it onto the Clipboard, leaving a blank white area behind. Once on the Clipboard, you can paste the area 
into another prop, actor cel, or Windows application.
To permanently remove the selected area, use the Edit Delete command.

Shortcut
Press Ctrl+X



Copy (Edit Menu of Paint Edit Window)
Places a copy of the graphic selected with either the Lasso or Marquee tool onto the Clipboard. Once on 
the Clipboard, you can paste the area into another actor cel, prop, or Windows application.

Shortcut
Press Ctrl+C



Paste (Edit Menu of Paint Edit Window)
Places a copy of the graphic currently on the Clipboard into your drawing. The original remains on the 
Clipboard until you copy or cut another object or end the current Windows session.
Shortcut

Press Ctrl+V



Delete (Edit Menu of Paint Edit Window)
Deletes the graphic selected with either the Lasso or Marquee tool. If no further action has been 
performed, you can restore a 
deleted graphic using the Undo command.

Shortcut
Press the DEL key.



Insert Cels (Edit Menu of Actor Edit Window)
Choose Insert Cels to call up the Insert Cels dialog. This command is not available when editing props.

Shortcut
Press Ctrl+T



Delete Cels (Edit Menu of Actor Edit Window)
Choose Remove Cels to call up the Delete Cels dialog. This command is not available when editing 
props.



Reverse Cels (Edit Menu of Actor Edit Window)
Choose Reverse Cels to reverse the ordering of all the cels in the actor.

For example, if an actor has 5 cels, in the original order of:
1 2 3 4 5

after the Reverse Cels menu option is executed, the cels order of the actor will become:
5 4 3 2 1

This command is not available when editing props.



Select All (Edit Menu of Actor/Prop Edit Window)
Selects the entire prop or actor cel, including any area not currently in view.



Registration (Edit Menu of Actor Edit Window)

Registration is only available when editing actors. When checked the registration point of an actor is 
displayed in the Paint editing window. The registration point is the spot that path points are anchored to.

To change the Registration point:
1. Check the Registration option under the Edit Menu.
2. Move the mouse to the location in the cel window where you want to set the actor's 

registration point.
3. Left Click and then release to set.
4. To leave the set registration mode, disable the Registration option in the Option Menu.

This command is not available when editing props.



Morph Cel (Effects menu of Paint Edit Window)
Choose morph to create the illusion of a transformation between two existing cels in a 
multiple-cel actor. This command is only available for multiple-cel actors.

To create a morphing effect between two cels:
1. Select the actor you want to morph
2. Choose Edit Object to load the actor into the Paint Window.
3. Use the cel selector to choose the preceding cel of the two you intend to morph. This 

cel will appear at the beginning of the morphing sequence.
4. Choose Morph Cel from the Effects menu. The Morph dialog box opens, with the From 

and To cels displayed in separate fields. A Pick tool and Zoom tool are available, 
located between the fields. 

5. Using the Pick tool, click in either the From or To field. A red point will appear in each. 
This is the first of the control points you will create. These are matched pairs of points 
and they determine how the morphing will proceed. As you create additional points, 
the currently-active pair will be shown in red and the others will be green.

6. Use the Pick tool to move these points around anywhere in the image fields.
During the morphing, the intermediate image stages created will show changes in 
relation and with respect to these points. When the images are morphed, the point 
pairs are used to control the change from one form to another, taking color, size, shape
and spatial location into account. The more points you use, the greater will be the 
control you have over the way the morphing proceeds. Up to 1000 points may be used.

7. Once you have created a set of morphing points, you can save the set using the Points-
Save button. This allows you to reload them at a later time, if you want to make 
changes to the way the morphing proceeds, or if you want to apply the same point set 
to another morphing sequence. Use the Clear button if you want to remove all points 
currently created.

8. Set the number of cels you want to use to perform the morphing in the Cels to Create 
field. The maximum valued allowed here is 200.

9. Click OK to begin morphing the cels. When the morphing is completed, you will be 
returned to the Paint Editor.

10. Choose Apply Changes from the File menu to finalize the process.



Tint Towards Foreground/Background (Effects Menu of Paint Edit 
Window)

Choose Tint to lighten or darken the selected part of the image towards the currently chosen foreground 
or background color. This process can be repeated until the desired tinting level has been achieved. 
Example.
If no selection has been made with either the marquee or lasso tool, the tint will apply to the entire frame 
of every cel of the actor or the entire frame of the prop.



For Example:
If you have chosen the foreground color to be dark blue and you are tinting your selected image towards 
the chosen foreground color, the image will become tinted darker towards dark blue. If you apply the 
process over and over again, any original white or light color parts of your image will eventually become 
totally dark blue.



Anti-Alias (Effects Menu of Paint Edit Window)

Choose Anti-Alias to remove the jagged or stair-step appearance from images as they step from one row 
or column to the next. Anti-Aliasing smooth the edges of a selected image by adding intermediate pixels. 
These pixels are grayish unless you have given the selection a background color. Anti-aliasing is 
especially useful when you are printing the finished animation to video or displaying it on a video screen.
If no selection has been made with either the marquee or lasso tool, the anti-alias will apply to the entire 
frame of every cel of the actor or the entire frame of the prop.



Rotate (Effects Menu of Paint Edit Window)
90° Clockwise

Choose 90° clockwise to turn the selected part of the image 90 degrees left.
90° Counterclockwise

Choose Rotate 90° counterclockwise to turn the selected part of the image 90 degrees 
right.

180°
Choose Rotate 180° to turn the selected part of the image 180°.

Free
Choose Rotate Free to turn the selected part of the image about its center freely and 
visually. Select a portion of the image using a selection tool, choose Rotate Free, then 
grab one of the four corner of the selection rectangle and rotate it clockwise or 
counter-clockwise. You will see the actual rotation changes when the mouse button is 
released.

Custom
Choose Custom to turn the selected portion of the image by the number of degrees 
specified in the Rotate By... dialog box. The number of degrees can be between 1 and 
180 and the selection can be rotated clockwise or counter-clockwise.

If no selection has been made with either the marquee or lasso tool, the rotation will apply to the entire 
frame of every cel of the actor or the entire frame of the prop.



Mirror (Effects Menu of Paint Edit Window)
Mirror Vertical

Choose Flip Vertical to flip the selected part of the image vertically about its center 
line.

Mirror Horizontal
Choose Flip Horizontal to flip the selected part of the image horizontally about its 
center line.

If no selection has been made with either the marquee or lasso tool, the mirror will apply to the entire 
frame of every cel of the actor or the entire frame of the prop.



Scale (Effects Menu of Paint Edit Window)
Scale Free

Choose Scale Free to scale the selected part of the image by grabbing one of four 
handles and resizing the selection freely. You can resize it using any different 
combination of the handles. This will continue to work until you select another tool or 
click on an area outside of the scaling rectangle. Hold down the SHIFT key to restrain 
the scaling to a proportional scaling.

Scale By Percent
Choose Scale by Percent to scale the selected part of the image by the values set in 
the Scale Selection By dialog. The selection can be scaled by changing the percentage 
vertically and horizontally.

If no selection has been made with either the marquee or lasso tool, the scale will apply to the entire 
frame of every cel of the actor or the entire frame of the prop.



Zoom (Option Menu of Paint Edit Window)

Choose Zoom to turn ZOOM or FATBITS editing mode on or off.
e.g. 1x means actual size of the bitmap

(editing in normal, non-zoomed mode)
2x means 2 times the actual size
(editing in FATBITS mode, each pixel is twice the width and height of the actual pixel)
4x means 4 times the actual size
(editing in FATBITS mode, each pixel is four times the width and height of the actual pixel)
8x means 8 times the actual size
(editing in FATBITS mode, each pixel is eight times the width and height of the actual 
pixel)



Font (Option Menu of Paint Edit Window)

Choose Font when in the Text Tool Mode to call up the Select Font dialog box. Once there, you can keep 
changing and experimenting with the different type faces, type size, and styles until the text image looks 
right.



Transparent (Option Menu of Paint Edit Window)

Choose Transparent to make the selected part of the image transparent. When you select part of the 
image and choose the Transparent command, you are making sure that you can see through it. Either 
Transparent or Opaque is checked at any given time.



Opaque (Option Menu of Paint Edit Window)

Choose Opaque to make the selected part of the image opaque. When you select part of the image and 
choose the Opaque command, you are making sure that you cannot see through it. Either Opaque or 
Transparent is checked at any given time.



Onion Skin (Option Menu of Paint Edit Window)

Onion Skin is only available when editing multi-cel actors. When chosen, it allows the previous or next cel 
of an actor to show through to the current cel. The other cel always appears behind the current cel at 30%
of the saturation of the original. Onion Skin provides for a method of tracing or aligning the current cel.

Onion Skin works in all levels of Zoom, but some operations might become slower when it is turned on.

Choose Previous Cel or Next Cel, or choose None to turn off the feature.



Marquee Tool 

Use the Marquee tool to select a rectangular area of an image. Drag diagonally across the 
area to select it.

To de-select an already selected area of an image, click on any white space just outside the 
selected rectangle.

To MOVE a selection, position the pointer inside the selection until the pointer changes to an 
arrow, then click and drag the selection.

To make a COPY of an area of an image, you must first drag diagonally across the area to 
select it, except in this case you must hold down the Ctrl key while dragging. Position the 
pointer inside the selection until the pointer changes to an arrow. Click and drag the 
selection to where you want to place it. Unlike the move selection, the original image will be 
left behind, unaltered.



Lasso Tool 

Use the Lasso tool to select a specific part of an image when the area is too small for the 
selection rectangle or when you need to select a part of the image that is non-rectangular or
between other graphics.

To use the Lasso tool, click and drag around the area you want. The line that trails the lasso's
tip shows what you are lassoing. When you release the mouse button, the area drawn by the
lasso's line is the selected area.

To de-select the selected area, click on any white space just outside the selected rectangle.

To MOVE a selection, position the Lasso tool's tip within the selection until the cursor 
changes to an arrow, then click and drag.

To make a COPY of an area of an image, you must first click and drag around the area you 
want, except in this case you must hold down the Ctrl key while dragging. Position the Lasso 
tool's tip in the selection until the cursor changes to an arrow. Click and drag the selection to
where you want to place it. Unlike the move selection, the original image will be left behind, 
unaltered.

For fine and precise placement of a selected MOVED or COPIED lassoed area, you can use 
the keyboard's UP, DOWN, LEFT, and RIGHT cursor keys to move the image one pixel row or 
one pixel column at a time in the direction you want.



Pencil Tool 

Use the Pencil tool to draw thin free-form lines. This is the most useful tool for working in 
Fatbits mode (magnified or detailed work).



Brush Tool 

Use the Brush tool to paint with the current brush shape. Using different brushes creates 
different effects when painting. 

To choose brush shape, double-click on the Brush tool button. A brush-shape selection pop-
up will appear, enable you to choose the desired brush shape.



Bucket Tool 

Use the Paint Bucket tool to fill solid areas of an image with the selected pattern and color.
The hollow parts of outlined and shadowed text can be filled in the same manner. 

If there is a gap or space in the outline of an area, paint spills out and fills the surrounding 
area of the image. Choose Undo from the Edit menu to correct the mistake. Use Fatbits to 
check for gaps before using the Paint Bucket tool.



Spraycan Tool 

Use the Spray Can tool to spray color onto an area of the image.

To get the Air Brush Setting dialog to pop up, double-click on the Spray Can tool icon.



Text Tool 

Use the Text tool to add text to the image. Use it for labels and titles within an image or by 
itself. Adding text has the same effects as the other tools, the text becomes part of the 
image. Immediately after typing the text and before clicking anywhere else on the screen, 
you can change the text's font, size and style by double-clicking on the Text tool icon to pop 
up the Select Font dialog box. Once there, you can keep changing and experimenting with 
the different type faces, type size and styles until the text image looks right. 

You can also change the color of the text by changing the current foreground color in the 
Foreground Color Pop-up.

To create a bounded text region on the paint canvas, you can hold down the Ctrl key and 
drag to mark out this region. After you have done so, the text cursor will stay at the upper 
left corner of the bounded text area. As you are typing, text will wrap at the right hand-side 
boundary.

To commit the text as part of the image, just click on anywhere else on the screen. If you 
make a mistake, choose Undo from the Edit menu.



Eraser Tool 

Use the Eraser tool to erase or remove part of the image you drag over. Hold down the Ctrl 
key to turn the Eraser tool into a Color Eraser. In the Color Eraser mode, the eraser removes 
only the selected foreground color. Any other color on the image remains.

For example, if you wanted to remove one of the colors in the sample actor Angry Fish such 
as the pink tongue. Select the pink with the Color Pick-up tool. Hold down the Ctrl key and 
select the Eraser. When you erase, only the pink color is the one removed from the image.



Color Pick-up Tool 

Use the Color Pick-up tool to select a color from part of the image.

The Paint Editor displays the 12 most recently used colors in the Recent Colors palette. If you
select a color using the Color Pick-up tool, it is added to the palette before the last color 
selected. Colors are added from left to right. When the palette has all 12 spaces filled, the 
next color is added in the last space and the first space will be removed. All previous colors 
are then pushed one space back in the palette.

Holding down the Ctrl key and clicking on an image fills all instances of the color you have 
clicked on with the selected color. You can use Undo to revert the change.



Line Tool 

Use the Line tool to draw straight lines. Choose the line thickness from the Line Width pop-
up.



Rectangle Tool 

Use the Rectangle Tool to draw rectangles. Position the cross-hair pointer where you want 
the rectangle to start; then drag diagonally. To change the thickness of the rectangle border, 
use the Line Width pop-up. To draw rectangles that are filled with the selected pattern and 
color, double-click the Rectangle tool in the Paint Tool palette.



Rectangle Filled Tool 

Use the Rectangle Filled Tool to draw filled rectangles. Position the cross-hair pointer where 
you want the rectangle to start; then drag diagonally. To change the thickness of the 
rectangle border, use the Line Width pop-up. To draw empty rectangles, double-click the 
Rectangle Filled tool in the Paint Tool palette.



Rounded Rectangle Tool 

Use the Rounded Rectangle tool to draw rectangles with rounded corners. Position the cross-
hair pointer where you want the rectangle to start; then drag diagonally. To change the 
thickness of the border, use the Line Width pop-up. To draw rounded rectangles that are 
filled with the selected pattern and color, double-click the Rounded Rectangle tool in the 
Paint Tool palette.



Rounded Rectangle Filled Tool 

Use the Rounded Rectangle Filled tool to draw filled rectangles with rounded corners. 
Position the cross-hair pointer where you want the rectangle to start; then drag diagonally. 
To change the thickness of the border, use the Line Width pop-up. To draw empty rounded 
rectangles, double-click the Rounded Rectangle Filled tool in the Paint Tool palette.



Oval Tool 

Use the Oval tool to draw oval shapes. Position the pointer where you want the oval to start, 
then drag diagonally. To change the thickness of the oval border, use the Line Width pop-up. 
To draw ovals that are filled with the selected pattern and color, double-click the Oval tool in 
the Paint Tool palette.



Oval Filled Tool 

Use the Oval Filled tool to draw filled oval shapes. Position the pointer where you want the 
oval to start; then drag diagonally. To change the thickness of the oval border, use the Line 
Width pop-up. To draw empty ovals, double-click the Oval Filled tool in the Paint Tool palette.



Curve Tool 

Use the Curve tool to draw free-form shapes. Position the pointer where you want to start, 
then drag out your shape. CorelMOVE will draw a straight line connecting the start and end 
points of the shape when you release the mouse button. To change the thickness of the 
curve shape's border, use the Line Width pop-up. To draw curves that are filled with the 
selected pattern and color, double-click the Curve tool in the Paint Tool palette.



Curve Filled Tool 

Use the Curve Filled tool to draw filled free-form shapes. Position the pointer where you want
to start, then drag out your shape. When you release the mouse button, CorelMOVE will 
draw a straight line connecting the start and end points of the shape and fill the shape. To 
change the thickness of the curve shape's border, use the Line Width pop-up. To draw empty
curves, double-click the Curve Filled tool in the Paint Tool palette.



Polygon Tool 

Use the Polygon tool to create polygons with irregular sides. This tool works differently than 
the other tools. To draw, position the mouse where you want to begin, then click and release.
Move the mouse to the second point and click; then to the third point and click and as many 
more as you want. To finish the polygon, double-click your last point. The last and first point 
are automatically joined. To change the thickness of the polygon border, use the Line Width 
pop-up. To draw polygons that are filled with the current pattern and color, double-click the 
Polygon tool in the Paint Tool palette.



Polygon Filled Tool 

Use the Polygon Filled tool to create filled polygons with irregular sides. This tool works 
differently than the other tools. To draw, position the mouse where you want to begin, then 
click and release. Move the mouse to the second point and click; then to the third point and 
click and as many more as you want. To finish the polygon, double-click your last point. The 
last and the first point are automatically joined. To change the thickness of the polygon 
border, use the Line Width pop-up. To draw empty polygons, double-click the Polygon Filled 
tool in the Paint Tool palette.



Pattern Selector 

The Pattern Fill pop-up palette displays a choice of available patterns you can use for paint 
and fill operations.

Selecting Patterns
To Select a pattern, click on the Patterns button, hold down the mouse button until the 
cursor is over the pattern you want, then release it.

The look and feel of a particular pattern on the Pattern pop-up is directly influenced by the 
currently selected foreground and background colors. Experiment by changing these colors 
to get the desired pattern effects.

The Pattern Fill pop-up is detachable. To detach the Pattern Fill pop-up:
a) click on the Patterns button and hold down the left mouse button AT THE SAME TIME.
b) while still holding down the left mouse button and with the Pattern Fill palette popped 

open, point the mouse cursor over one of the patterns until it is highlighted with a black 
rimmed square outline.

c) still holding down the left mouse button, drag the black rimmed square highlight towards 
and cross any one of the four edge of the pattern pop-up window until the Pattern pop-up 
is separated from the Tools Palette.

d) release the mouse button.

When the Pattern Fill pop-up is detached, you can click directly on the pattern you want to 
use and move the window to any where you wish.



Foreground Color Selector 

The Foreground Color pop-up palette displays a choice of available colors for painting in 
foreground colors.

Selecting Foreground Colors

To select a foreground color, click on the Foreground button, hold down the mouse button 
until the cursor is over the color you want to use, then release it.

The Foreground Color pop-up is detachable. To detach the Foreground Color pop-
up:
a) click on the Foreground button and hold down the left mouse button AT THE SAME TIME.
b) while still holding down the left mouse button and with the Foreground Color palette open,

point the mouse cursor over one of the colors until it is highlighted with a black rimmed 
square outline.

c) still holding down the left mouse button, drag the black rimmed square highlight towards 
and across any one of the four edges of the Foreground Color pop-up window until the pop-
up window is separated from the Tools Palette.

d) release the mouse button.

Color Palette in Detached Mode

When the Color Palette pop-up is detached, you can:
- click directly on the color you want to use 

- choose both the foreground and the background colors
The current chosen foreground color is highlighted with a blue color square border, whereas
the background color is highlighted with a red color square border. To set the foreground 
color, click on the color you want to select with the left mouse button. To set the 
background color, click on the color you want to select with the right mouse button.

- sort Palette
To sort the Color Palette, click on the system box and choose the Sort Palette menu option. 
A list of sorting choices will be available for you to choose from. The default sorting order is 
the Palette Order.



Background Color Selector 

The Background Color pop-up palette displays a choice of available colors for painting in 
background colors.

Selecting Background Colors

To select a background color, click on the Background button, hold down the mouse button 
until the cursor is over the color you want to use, then release it.

The Background Color pop-up is detachable. To detach the Background Color pop-
up:
a) click on the Background button and hold down the left mouse button AT THE SAME TIME.
b) while still holding down the left mouse button and with the Background Color palette 

open, point the mouse cursor over one of the colors until it is highlighted with a black 
rimmed square outline.

c) still holding the left mouse button down, drag the black rimmed square highlight towards 
and across any one of the four edges of the Background Color pop-up window until the 
pop-up window is separated from the Tools Palette.

d) release the mouse button.

Color Palette in Detached Mode

When the Color Palette pop-up is detached, you can:
- click directly on the color you want to use 

- choose both the foreground and the background colors
The current chosen foreground color is highlighted with a blue color square border, whereas
the background color is highlighted with a red color square border. To set the foreground 
color, click on the color you want to select with the left mouse button. To set the 
background color, click on the color you want to select with the right mouse button.

- sort Palette
To sort the Color Palette, click on the system box and choose the Sort Palette menu option. 
A list of sorting choices will be available for you to choose from. The default sorting order is 
the Palette Order.



Line Width Selector 

Line widths displayed in the Paint Tools palette are measured in pixels. Click on the Line 
Width pop-up, then select one of the nine possible widths.



Recent Color Pick-up 

Recent Colors are displayed in the Paint palette to allow for convenient selection the 12 most
recent colors that have been used. To select a color, click one of the palette choices. To 
assign a color as a background color, use the Right mouse button when clicking.

Adding or Changing Recent Colors
Select a new color from either the Foreground or Background Color pop-up, and it is 
automatically added onto the Recent Color Pick-up palette. The colors are added in order of 
selection from upper left to lower right. After the first 12 colors are added, colors are 
dropped from the lower right corner of the palette as you continue adding. The most 
recently selected color is added in the upper left corner of the palette. All the colors are 
shifted from left to right and top to bottom, one palette position at a time.



Cel Counter 

The cel count is displayed by first showing the current actor cel number, then the number of 
total cels in the actor.



Move-to-Cel Scroll Bar 

Click on the scroll bar to advance to the next or previous frames of the actor currently being 
edited.



Overview (Wave Edit Window)
A waveform is a graphic representation of a sound, with time along the x-axis and volume 
along the y-axis. You can modify a Sound by altering its waveform using a variety of tools 
provided in the Wave Editor.

Some of the things you can do with your sound sample in the Wave Editor are:
- change its volume level
- change its sampling rate
- convert from stereo to mono and vice versa
- change the bit width of the sound (8 bits vs. 16-bits sound)
- giving it interesting sound effects characteristics such as: echo, reverse, fade up, fade 

down.
- editing and customizing it by using the select, undo, cut, copy, paste, delete and insert 

silence capability
- monitor the sound and it changes by the playback and stop buttons



 Control Menu Box (Wave Edit Window)
Located at the left end of the Title bar in the wave editing window. Clicking on the Control Menu box 
displays commands for sizing and positioning the window. See Control Menu Commands



Editing Window

This window provides a visual representation of the sound wave.
In this window area, you can:
View the Waveform
Set the cursor/insertion line
Select some or all of the waveform



View the waveform
The sound waveform being edit is plotted in this window. Depending on the degree of 
magnification that you are using, you can see it in its entirety or a portion using the Zoom 
In/Out scroll bar. The sound sample starts from the left edge of the window and ends 
towards the right side.



Set cursor/insertion line
In order to paste a sound from the clipboard, you must tell the Wave Editor where to insert, 
by positioning the insertion line. To position the insertion line, simply use the mouse and 
click on the exact point in the window where you want to insert or paste the sound. A black 
line will appear as the insertion line. The sound will be inserted after (or to the right of) the 
insertion line using the Paste command.
To cancel a selected block of sound samples, simply do a single click anywhere within this 
window.



Select a section of the sound waveform
To edit, apply a sound effect or playback a specific section of a wave file you must first make
a selection.
To select a section of a sound, highlight the area in the window by clicking the mouse down 
until an insertion line appears, then drag the mouse in either direction to select a section of 
the sound and release the mouse. The area actually selected is shown in an inverted color, 
or cyan on black background color. You can also tell the exact range of your selection in the 
unit of sample number in the status bar on the bottom of the Wave Editor.



Play Button

 Choose Play to playback an entire sound waveform or a selected portion of it.

Shortcut
Ctrl+P



Record Button

 Choose Record to record a sound waveform. This feature will only work if sound-
capturing hardware has been installed in your computer.



Scroll Bar

When the entire length of the sound can not be displayed all at once within the width of the 
Wave Form View & Select Window, you can use this scroll bar to reach other parts of the
sound that are not currently in view.



Status Bar

The Status Area in the Wave Editor shows what section of the sound waveform is currently 
selected, as well as the characteristics of the entire sound sample.

The From and To field indicate precisely the range of the sound sample you have selected. 
This status is shown so that you can control exactly which sample in the waveform to start 
and end the highlight or selection.

From: indicates the starting sample number in a given selection of the sound waveform.
To: indicates the ending sample number in a given selection of the sound waveform.

22KHzis the sample rate. Sample rates are measured in a unit called Kilo-Hertz (1 KHz = 
one thousand cycles per second). Generally, the higher the sample rate, the more 
accurate is the reproduction of a sound. Some of the popular sound sample rates 
used in sampling sound waveforms are 44KHz, 22KHz and 11KHz. Due to possible 
sound hardware limitations, software driver limitations or disk and memory storage 
limitations, one is forced to convert a sound sample rate from one to another.

8bit is the bit width or the volume resolution of the sound sample. For example, a given 8 
bit sound has 2 to the 8th power (or 256) units in volume level per sample and a 16 
bit sound has 2 to the 16th power (or 65536) units in volume level per sample. The 
higher the bit width of the sound, the more accurate the volume change between 
samples can be reproduced, thus resulting in a higher and finer quality sound 
reproduction.

Mono indicates whether the given sound sample is a one channel (mono) sound or a two 
channel (stereo) sound.



Stop Button

 Choose Stop to halt the playback of sound waveform.

Shortcut
Ctrl+S



Title Bar
Located along the top of a window, the Title Bar displays the word Wave Editor: followed by the name of 
the wave you are working on. Dragging the Title Bar moves the window.

The Title Bar contains the following button for controlling the window:

 Control Menu box



Window Border
Borders appear around windows that are less than full size. Dragging the border lets you make the 
window smaller or larger.

· Drag the top, bottom or side border to size the window in one direction only.

· Drag the corner of the border to size the window vertically or horizontally.

With the window less than full size, you can also choose Size from the Control menu, then use the arrow 
keys to size the window.



Zoom Scroll Bar

Use this scroll bar to control how magnified or small you want to view a given section of a 
sound. If you drag the scroll bar button left, it will increase the zoom magnification of the 
sound wave section you are viewing, providing a more detail view of the wave 
characteristics. Full editing capability is available under zoom mode. Dragging the scroll bar 
towards the right will un-zoom the view back towards normal full length view.



Control Menu (Wave Editing Window)
Restore (not accessible in the Wave Editing window)
Move 
Size (not accessible in the Wave Editing window)
Minimize (not accessible in the Wave Editing window)
Maximize (not accessible in the Wave Editing window)
Close
Switch To



Move (Control Menu of Wave Edit Window)
Use this command to display a four-headed arrow so you can move the Wave Edit window with arrow 
keys.

Note: This command is unavailable if you maximize the window.



Close (Control Menu of Wave Edit Window)
Use this command to close the Wave Edit window.

Double-clicking a Control-menu box is the same as choosing the Close command.



Switch To (Control Menu of Wave Edit Window)
Use this command to display a list of all open applications. Use this Task List 
to switch to or close an application on the list.

Shortcut
Ctrl+Esc

Dialog Box Options
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar. 
Note: This option does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.
Note: This option does not affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.





Apply Changes (File Menu of Wave Edit Window)

Choosing Apply Changes will update the wave file in the Timelines Roll-Up to reflect any changes made 
in the Wave Edit window.



Play (File Menu of Wave Edit Window)

Choose Play to playback an entire sound waveform or a selected portion of it.

Shortcut
Keys: Ctrl+P
Buttons: 



Stop (File Menu of Wave Edit Window)

Choose Stop to halt the playback of sound waveform.

Shortcuts
Keys: Ctrl+S
Buttons: 



Exit (File Menu of Wave Edit Window)

Choose Exit to quit the Wave Editor. If the sound waveform has been changed in any way, 
CorelMOVE will automatically prompt you to Apply Changes before closing the editing window.





Undo (Edit Menu of Wave Edit Window)

Choose Undo to undo most operations within the Wave Editor.

Shortcut
Press Ctrl+Z



Cut (Edit Menu of Wave Edit Window)

Choosing Cut will first copy the selected section of waveform onto the Windows' Clipboard, 
then the selected section will be removed from the Wave Editor immediately after the copy. 

To Cut a section of a sound, highlight the area by clicking the mouse down until an insertion 
line appears. Drag the mouse in either direction to select a section of the sound. Select Cut 
to move the selection to the Windows' Clipboard.

Shortcut
Press Ctrl+X



Copy (Edit Menu of Wave Edit Window)

Choosing Copy will copy the selected section of waveform onto the Windows' Clipboard.

To Copy a section of sound, highlight the area by clicking the mouse down until an insertion 
line appears. Drag the mouse in either direction to select a section of the sound. Select the 
Copy command to move a duplicate of the selection to the Clipboard.

Shortcut
Press Ctrl+C



Paste (Edit Menu of Wave Edit Window)

Choose Paste to paste a section of a sound from the Clipboard. To do so, click the mouse 
down in an area on the waveform where you want to insert the sound. An insertion line 
appears. Select Paste to insert the portion of the sound from the Clipboard into the 
waveform. The pasted portion of the sound will appear in the waveform. The size of the 
sound will change because you are adding to the sound.

Shortcut
Press Ctrl+V



Delete (Edit Menu of Wave Edit Window)

Choose Delete to remove a section of a sound. To do so, highlight the area by clicking the 
mouse down until an insertion line appears. Drag the mouse in either direction to select a 
section of the sound. Select Delete to remove the selection. The selected portion of the 
sound will be removed.

Shortcut
Press Del



Select All (Edit Menu of Wave Edit Window)

Choosing Select All highlights the entire waveform and is the equivalent of dragging the 
mouse from the start of the sound waveform to the end.

NOTE: Most sound editing operations affect the entire sound if there is no selection. If you 
select part of the waveform, only that area is affected by the editing operation.

Shortcut
Press ALT+E,S





Change Characteristics... (Effects Menu of Wave Edit Window)

Choose Change Characteristics... to display the Change Wave Characteristics dialog box. 
This dialog box allows you change the sample rate and size of the waveform as well as the 
number of channels the sound file contains.



Silence (Effects Menu of Wave Edit Window)

Choose the Silence effect to insert intervals of silence into your sound waveform.



Fade Up (Effects Menu of Wave Edit Window)

Choose the Fade Up effect to cause a sound to start relatively softly and end in a relatively 
louder volume. If you select a section of sound to apply this effect to, only the selected 
portion is affected.



Fade Down (Effects Menu of Wave Edit Window)

Choose the Fade Down effect to cause a sound to start in a relatively louder volume and 
end in a relatively softer volume. If you select a section of sound to apply this effect to, only 
the selected portion is affected.



Amplify... (Effects Menu of Wave Edit Window)

Choose the Amplify... effect to increase or decrease the volume of a selected section of the 
sound waveform. The entire sound is affected if a selection is not made.



Reverse (Effects Menu of Wave Edit Window)

Choose the Reverse effect to cause a section of sound or the entire sound to play 
backward.



Echo (Effects Menu of Wave Edit Window)

Choose the Echo effect to cause an echoing affect on the section of sound you are editing. If
a selection is not made, the entire sound is affected.





Left Channel (View Menu of Wave Edit Window)

If the sound waveform is a stereo sound, selecting Left Channel will enable you to view and
edit the left channel of the stereo sound waveform.



Right Channel (View Menu of Wave Edit Window)

If the sound waveform is a stereo sound, selecting Right Channel will enable you to view 
and edit the right channel of the stereo sound waveform.





Actor Information

The Actor Information dialog allows the user to get information on and modify the various properties and 
attributes of the actor that is currently selected.

Name: The name of the currently selected actor. The text can edited directly to rename 
the actor.

Locked: Enabling this option prevents the actor from accidentally being moved on stage 
by the mouse.

Enters At Frame: The number of the animation frame in which the actor first appears.
Exits At Frame: The number of the animation frame in which the actor exits the stage.
Start Position - Horiz The horizontal coordinate of the actor relative to upper left corner of the 

animation window. This value is usually the starting horizontal position of the 
actor's path.

Start Position - Vert The vertical coordinate of the actor relative to upper left corner of the animation 
window. This value is usually the starting vertical position of the actor's path.

Path - Start At Point An alternative starting path point for an actor can be set using this field. The 
default starting path point for an actor is point 1.

Convert Click on this button to convert the actor to a CorelMOVE object.
Edit Actor Click on this button to open the Paint Editor and loads the currently selected 

actor.
OK Click the OK button to accept the actor properties specified with the various 

dialog box controls.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Air Brush Settings

The Air Brush Settings dialog box allows the user to change the density and area of the spraying color.

Aperture Width The aperture width is the size of the spray measured in pixels. If the aperture width is 
set to 100 then a circle with a radius of 100 pixels will be sprayed. The aperture width 
can have a value of 1 to 300 pixels.

Pressure The pressure setting controls the density of sprayed color. For example, if the Aperture
Width is set at 100 pixels and the pressure is set to 200, there should be 
approximately 200 colored dots sprayed in a circle with a radius of 100 pixels. The 
pressure setting can have a value of 1 to 750 dots.

OK Click OK to accept the air brush settings.
Cancel Click Cancel to abandon any changes and close the dialog box.



Amplify Selection

The Amplify Selection dialog box is used to increase or decrease the volume level of the current 
selection or entire waveform.

Amplification An amplification factor greater than 100% will increase the sound level, less than 
100% will decrease the sound level, and 100% will have no affect. The amplification 
level must be between 1 and 10000 percent.

OK Click OK to apply the amplification.
Cancel Click Cancel to abandon the effect and close the dialog box.



Animation Information
This dialog box allows you to display and change some of the settings of the current animation.

Number Of This group lists the types and number of objects in the current animation.
Window Edit this group to modify the size (in pixels) of the current animation window.

The two fields, Height: and Width:, hold the current dimensions of the 
animation window. Change them by clicking on the scroll buttons or edit the 
values directly. The default size is 480x360. Some of the other popular sizes 
for defining a new animation window are 320x200, or 640x480.

Number of Frames This field indicates the number of frames in the animation. To change the 
number of frames, click on the scroll buttons or edit the value directly. The 
maximum length of an animation is 9999 frames.

Frame for Thumbnail The value entered in this field indicates which frame of the animation is to be 
used as the thumbnail in Preview windows such as the one in the Open 
Animation dialog box

Speed (Frames/Second) The animation speed is measured in frames per second (fps). The available 
speeds range from 1 to 18 fps. The animation speed varies from one system 
to another and is dependent on the amount of RAM, the processor and the 
access time of the hard disk.

Grid Spacing This pop-up menu is used to set an invisible grid. When you add points on a 
path or move actors or props on the screen, they are placed to the nearest 
specified pixel. If you choose 5 from the pop-up menu, the points are placed 
to the nearest 5th pixel from the top left of the window. The grid is invisible 
and has a range of every 5 pixels to every 200 pixels. If you want to turn off 
the grid, choose OFF from the pop-up menu.

OK Click OK to accept the Animation properties.
Cancel Click Cancel to abandon any changes you have made and close the dialog 

box.



Browse
The Browse dialog box allows you to select a file from which a new CorelMOVE object will be created.

File Name: Use the File Name: text box to specify the filename here by directly typing it in. 
Press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available 

drives on the system.
OK Click the OK button to accept the filename, drives, and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Change Wave Characteristics
The Wave Information dialog allows the user to get information on and modify the various properties and
attributes of a Sound that is created in an animation.

Sample Rate: Sample rates are measured in a unit called Kilo-Hertz (1 KHz = one thousand 
cycles per second). Generally, the higher the sample rate, the more accurate 
the reproduction of a sound. Some of the popular sound sample rates used in
sampling sound waveforms are 44KHz, 22KHz and 11KHz. Due to possible 
sound hardware limitations, software driver limitations, or disk and memory 
storage limitations, it may be necessary to convert from one sample rate to 
another.

Sample Size: Sample size is the bit width or the volume resolution of the sound sample. For 
example, a given 8 bit sound has 2 to the 8th power (or 256) units in volume 
level per sample and a 16 bit sound has 2 to the 16th power (or 65536) units 
in volume level per sample. A higher bit width stores a more accurate 
sampled volume change and reproduces a finer quality of sound.

Channels The Channels group allows the user to choose between one channel (mono) or two 
channel (stereo) output. If the sound file is already mono, the selection here would not
make any difference.

OK Click OK when you are done changing any components and attributes of the Sound and 
to ask CorelMOVE to accept the new changes.

Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Choose A Key
The Choose A Key dialog box allows you to select a keypress that the cue will respond to. To make a 
selection simply press 
any key on the keyboard and the key name will be displayed in the Currently field.
F1 was pressed to get this help topic and as a result when you close this help screen, the dialog box will 
show F1 as the current selection. Leaving F1 as the cue response key is not recommended because it 
could interfere with access to other help topics.

To close the dialog box, you must either press Alt+F4 or use the mouse to click on OK or Cancel.



Conversion Options
The Conversion Options dialog box allows you to convert objects from their original file type to a 
CorelMOVE file type. After you convert the object, it can only be edited in CorelMOVE.



Cue Information
Use the Cue Information dialog to create a new cue, or change information about an existing cue. To 

create a new cue, the Cue Information dialog box can be accessed from the Add Cue button . To edit
an existing cue, double click on the cue object name that you want to modify. The Cue Information dialog 
box opens.

Name The field indicates the name of the current cue you are editing. If you 
are creating a cue, this field will contain the default name Untitled. This 
name must be replaced with another named before CorelMOVE will 
accept it. Use this field to name your cue by typing in a new name.

Enters At Frame The number of the animation frame where the cue first becomes 
active.

Exits At Frame The number of the last animation frame where the cue is active.
OK Click OK to accept changes that are made to the cue being edited and 

exit the cue dialog.
Cancel Click Cancel to abandon any changes you have made and 

close the dialog box.

Condition Construction Box The Condition box provides a simple way to set conditions for cues in 
your animation. All the conditions are accessed through drop-down list 
boxes. See Creating Cues for more information.

Action(s) Construction Box The Action follows the successful meeting of a cue's condition. See 
Action field on the Cue Information dialog for more information.

Add Use this button to add another action line at the end of the action list.
Insert Use this button to insert another action line immediately following the 

currently highlighted line.
Update Click Update to accept changes made to the current action.
Delete Use this button to remove the currently highlighted action line.



Delete Cels
The Delete Cel dialog box allows you to delete cels from an actor. The current cel and the cels after are 
deleted.
NOTE: This procedure cannot be undone.

Current Cel: Indicates the number of the currently displayed cel.
Number of Cels to Delete: Enter the number directly or use the scroll arrows to set the number of cels 

you wish to delete. The maximum number of cels you can delete at one 
time is 20.

OK Click the OK button to delete the cels.
Cancel Click Cancel to abandon the Delete Cels procedure and close the dialog 

box.



Duplicate Actor
The Duplicate Object dialog provides a means for you to specify a unique name for the object that you 
are about to duplicate in the animation object library. Note: all objects in the object library of a particular 
object type must have a unique name before CorelMOVE will store it.

Name: Type in a unique name to be used as a library object name for the object you are about to 
duplicate. By default, CorelMOVE will append a number to the end of the object's existing 
name. If you are satisfied with the suggested default name, you can accept it by pressing 
ENTER or click on the OK button.

OK Click OK if you are satisfied with the name you have just entered in the text field above and 
want to proceed to duplicate the object and save it under the new name.

Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Duplicate Prop
The Duplicate Object dialog provides a means for you to specify a unique name for the object that you 
are about to duplicate in the animation object library. Note: all objects in the object library of a particular 
object type must have a unique name before CorelMOVE will store it.

Name: Type in a unique name to be used as a library object name for the object you are about to 
duplicate. By default, CorelMOVE will append a number to the end of the object's existing 
name. If you are satisfied with the suggested default name, you can accept it by pressing 
ENTER or click on the OK button.

OK Click OK if you are satisfied with the name you have just entered in the text field above and 
want to proceed to duplicate the object and save it under the new name.

Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Duplicate Wave
The Duplicate Object dialog provides a means for you to specify a unique name for the object that you 
are about to duplicate in the animation object library. Note: all objects in the object library of a particular 
object type must have a unique name before CorelMOVE will store it.

Name: Type in a unique name to be used as a library object name for the object you are about to 
duplicate. By default, CorelMOVE will append a number to the end of the object's existing 
name. If you are satisfied with the suggested default name, you can accept it by pressing 
ENTER or click on the OK button.

OK Click OK if you are satisfied with the name you have just entered in the text field above and 
want to proceed to duplicate the object and save it under the new name.

Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Edit Zoom, Edit Zoom Rectangles & Edit Scroll
This Edit dialog box allows you to enter the horizontal and vertical entry/exit position (in pixels) in the Prop
Origin box. This is the location in the Animation window at which entry or exit of the prop occurs. Click and
drag anywhere on the Prop Origin View area to set the origin. The number entered in the Steps field 
determines how many steps it will take for the prop to enter or exit the animation.



Export to Movie
The Export to Movie dialog box allows you to specify a filename of a particular type, drive, and directory, 
so that CorelMOVE can export an animation to a movie.

File Name: Use the File Name: textbox to specify the filename by directly typing it in. Press 
ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available drives

on the system.
OK Click the OK button to accept the filename, drives and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon the export procedure and close the dialog box.



Export to Individual Files
The Export to Individual Files dialog box allows you to specify filenames of a particular type, drive, and 
directory, so that CorelMOVE can export an animation to individual files.

File Name: Use the File Name: textbox to specify the filename by directly typing it in. Press 
ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available drives

on the system.
OK Click the OK button to accept the filename, drives and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon the export procedure and close the dialog box.



Export to Sound
The Export to Sound dialog box allows you to specify a filename of a particular type, drive, and directory, 
so that CorelMOVE can export a sound file.

File Name: Use the File Name: textbox to specify the filename by directly typing it in. Press 
ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available drives

on the system.
OK Click the OK button to accept the filename, drives and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon the export procedure and close the dialog box.



Fade Selection Up/Down
The Fade Selection Up dialog box is used to make the current selection or entire waveform start at a 
volume level of zero and increase to the Maximum Level. The maximum level is a percentage of the 
current level. The maximum level is between 0 and 100 percent.

The Fade Selection Down dialog box is used to make the current selection or entire waveform start at 
the current volume level and decrease to the Minimum Level. The minimum level is a percentage of the 
current level. The minimum level is between 0 and 100 percent.

OK Click OK to apply the fade affect.
Cancel Click Cancel to abandon the affect and close the dialog box.



Go to Frame

The Go to Frame dialog box allows you to go to any frame of the animation. The frame number you enter
can be between 1 and the total number of frames in the animation.

OK Click OK to go to the selected frame.
Cancel Click Cancel to abandon the Go to Frame procedure and close the dialog box.



Import Actor
The Import Actor dialog box is used to specify a filename of a particular type, drive, and directory.

File Name: Use the File Name: textbox to specify the filename by directly typing it in and then 
press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename 
extension.

Drives: Use the Drives: combo box to change the current drives from a list of available 
drives on the system.

OK Click the OK button to accept the filename, drives, and path that you have just 
specified with the various dialog box controls.

Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Import Actor from Bitmap File(s)
The Import Actor from Bitmap File(s) dialog box is used to specify filenames of a particular type, drive, 
and directory.

File Name: Use the File Name: textbox to specify the filename by directly typing it in and then 
press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename 
extension.

Drives: Use the Drives: combo box to change the current drives from a list of available 
drives on the system.

OK Click the OK button to accept the filename, drives, and path that you have just 
specified with the various dialog box controls.

Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Import Imaging Options
The Import Imaging Options dialog box allows you to control the appearance of imported graphics by 
performing high quality dithering or by making black or white areas of the graphic transparent.



Import Object
This dialog box is used to specify a filename of a particular type, drive, and directory.

File Name: Use the File Name: textbox to specify the filename by directly typing it in and then 
press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available 

drives on the system.
OK Click the OK button to accept the filename, drives, and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.

See also:
Import Actor
Import Prop
Import Sound



Import Prop
The Import Prop dialog box is used to specify a filename of a particular type, drive, and directory.

File Name: Use the File Name: textbox to specify the filename by directly typing it in and then 
press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available 

drives on the system.
OK Click the OK button to accept the filename, drives, and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Import Sound
The Import Sound Dialog is used to import Wave Files (.WAV), as well as sounds contained within other 
CorelMOVE (.CMV), Motion Works (.MWF) and Video for Windows (.AVI) files.

File Name: Use the File Name: textbox to specify the filename by directly typing it in and then 
press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available 

drives on the system.
OK Click the OK button to accept the filename, drives, and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Insert Cels
The Inserts Cel dialog box allows you to insert a number of cels either before or after the current cel.

Current Cel: Indicates the number of the currently displayed cel.
Number of Cels to Insert: Enter the number directly or use the scroll arrows to set the number of cels 

you wish to insert. The maximum number of cels you can insert at one time is
20.

Insertion Position: The Before Current Cel and After Current Cel radio buttons determine 
where the new cels are inserted relative to the current cel.

Duplicate Contents: Enabling this option will cause a duplicate the contents of the current cel to 
be placed into every new cel that is inserted.

OK Click the OK button to insert the new cels.
Cancel Click Cancel to abandon the Insert Cels procedure and close the dialog box.



Move to Frame
Use the Move to Frame... dialog to go directly to a particular frame in the currently loaded animation.

Show Frame: Enter the frame number that you want to move to in the animation.
OK Click OK to accept your input to the text box.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.



New Actor
This dialog box provides you with an opportunity to specify a unique name for the actor you are creating.

Object Name: Type in a unique object name in this text field, and press Enter or click 
OK to accept the name.

Create New/Create from File Click on one of the two radio buttons in order to specify whether the 
actor is created from 'scratch' or from an existing file.

Object Type Select from this list box an object type to insert. This list is only available
when Create New is enabled.

File Enter the name of a file from which a new object will be created. If you 
cannot remember the file name, click on the browse button to locate the 
file. This button is only available when Create from File is selected.

OK Click this button if you are satisfied with the name of the object to be 
created and wish to proceed to create the object.

Cancel Click Cancel to abandon the new actor creation and close the dialog 
box.

Browse Click Browse to open the Browse dialog box. This button is only 
available when Create from File is selected.

Result Describes the outcome of selecting OK.



New Library
The New Library dialog box lets the user create a new Library (.MLB file) to open.

File Name: Use the File Name: textbox to enter the library filename by directly typing it in and 
then press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
Save File as Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available 

drives on the system.
OK Click the OK button to accept the filename, drives, and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon the new library creation and close the dialog box.



New Prop
This dialog box provides you with an opportunity to specify a unique name for the prop to be created.

Object Name: Type in a unique object name in this text field and press Enter or click 
OK to accept the name.

Create New/Create from File Click on one of the two radio buttons in order to specify whether the 
prop is created from 'scratch' or from an existing file.

Object Type Select from this list box an object type to insert. This list is only available
when Create New is enabled.

File Enter the name of a file from which a new object will be created. If you 
cannot remember the file name, click on the browse button to locate the 
file. This button is only available when Create from File is selected.

OK Click this button if you are satisfied with the name of the object to be 
created and wish to proceed.

Cancel Click Cancel to abandon the new prop creation and close the dialog 
box.

Browse Click Browse to open the Browse dialog box. This button is only 
available when Create from File is selected.

Result Describes the outcome of selecting OK.



New Wave
This dialog box provides you an opportunity to specify a unique name for the wave file to be created.

Object Name: Type in a unique object name in this text field and press Enter or click 
OK to accept the name.

Create New/Create from File Click on one of the two radio buttons in order to specify whether the 
wave file is created from 'scratch' or from an existing file.

Object Type Select from this list box an object type to insert.
File Enter the name of a file from which a new object will be created. If you 

cannot remember the file name, click on the browse button to locate the 
file

OK Click this button if you are satisfied with the name of the object to be 
created and wish to proceed.

Cancel Click Cancel to abandon the new wave creation and close the dialog 
box.

Browse Click Browse to open the Browse dialog box.
Result Describes the outcome of selecting OK.



Open Animation File
The Open an Animation dialog box lets you choose an animation file (.CMV) to open.

File Name: Use the File Name: textbox to specify the filename by directly typing it in and then 
press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename 
extension.

Drives: Use the Drives: combo box to change the current drives from a list of available 
drives on the system.

OK Click the OK button to accept the filename, drives, and path that you have just 
specified with the various dialog box controls.

Cancel Click Cancel to abandon the open file operation and close the dialog box.



Open Library
The Open Library dialog box lets the user choose a Library (.MLB file) to open.

File Name: Use the File Name: textbox to specify the library filename by directly typing it in and 
then press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
List Files of Type: Use the List Files by Type: combo box to change the filename extension pattern so 

that File Name: listbox will only list the filenames of the selected filename extension.
Drives: Use the Drives: combo box to change the current drives from a list of available 

drives on the system.
OK Click the OK button to accept the filename, drives, and path that you have just 

specified with the various dialog box controls.
Cancel Click Cancel to abandon the open library operation and close the dialog box.



Point Information
The Point Information dialog box displays the horizontal and vertical screen location of a path point, as 
well as it's sequential position and loop status. You can change the point's screen location by entering 
new Horizontal and Vertical coordinates.

If you want the point to be the loop point on the path, enable the Loop To Here box. Creating a loop point
causes the actor to animate continuously around the path, jumping from the endpoint back to the loop 
point.



Preferences

Playback Options
This section allows you to control the playback of your animation.

Stop Animation On: You can select from the Mouse Button Click or Ctrl-Break to 
stop the animation. When the selected button is pressed during playback, the 
animation stops. Pressing Esc will also stop the animation at any time.

Hide Tools: Hides all tools such as the Toolbox and the Control Panel.
Hide Menu Bar hides the menu bar while the animation is playing.
Hide Cursor hides the cursor while the animation is playing. When you switch to another

application, the cursor appears; when you switch back to the animation, it disappears 
again.

Enable Sounds: This option toggles the sound on and off during playback. You can also 
use the sound icon on the Control Panel to enable and disable sounds.

Auto Replay: Select Auto Replay to make the animation repeat or loop automatically. If 
selected, the animation runs repeatedly until you stop it. If not selected, the animation 
runs through once. You can also use the Loop icon on the Control Panel to set Auto 
Replay.

Note: If you hide the palettes and the menu bar while the animation is set to Auto Replay, you can stop 
the animation by pressing Esc or by using the keys you designated in the Stop Animation On section of 
this dialog box.

New Animation
This section allows you to change the default settings for new animations.

Window Size Edit this group to modify the size (in pixels) of new animation windows.
The two fields, Height: and Width:, hold the current default dimensions. 
Change them by clicking on the scroll buttons or edit the values directly. The 
default size is 640x480. Some of the other popular sizes for defining a new 
animation window are 320x200, or 480x360.

Number of Frames This field indicates the number of frames in the animation. To change the 
number of frames, click on the scroll buttons or edit the value directly. The 
maximum length of an animation is 9999 frames.

Frame for Thumbnail The value entered in this field indicates which frame of the animation is to be 
used as the thumbnail in Preview windows such as the one in the Open 
Animation dialog box

Speed (Frames/Second) The animation speed is measured in frames per second (fps). The available 
speeds range from 1 to 18 fps. The animation speed varies from one system 
to another and is dependent on the amount of RAM, the processor and the 
access time of the hard disk.

Grid Spacing This pop-up menu is used to set an invisible grid. When you add points on a 
path or move actors or props on the screen, they are placed to the nearest 
specified pixel. If you choose 5 from the pop-up menu, the points are placed 
to the nearest 5th pixel from the top left of the window. The grid is invisible 
and has a range of every 5 pixels to every 200 pixels. If you want to turn off 
the grid, choose OFF from the pop-up menu.

OK Click OK to accept the Animation properties.



Cancel Click Cancel to abandon any changes you have made and close the dialog 
box.

Imaging Options
This section allows you to change the default settings for imported images and animations.

Always prompt for Select this option to always prompt the user for 
imaging options Imaging Options when an animation or image is imported.

Perform high quality Select this option to perform high quality
dithering dithering on imported images and animations.

Transparent Color Select White, Black or None as the color that is to be transparent on the 
imported actor or prop.
The Color tolerance setting determines how close to black or white a color 
has to be before it becomes transparent.

OK Click OK to accept the Imaging Options.
Cancel Click Cancel to abandon any changes you have made and close the dialog 

box.



Prop Information
The Prop Information dialog box allows you to modify and get information about the various properties 
and attributes of the currently selected prop.

Prop Name: This indicates the name of the prop. You can edit this name to rename the actor.
Locked: Enabling this option prevents the prop from accidentally being moved on stage by 

the mouse.
Enters At Frame: This tells you what the starting frame is for the prop. You can modify this field to 

change the start frame of the prop.
Exits At Frame: This tells you what the ending frame is for the prop. You can modify this field to 

change the ending frame of the prop.
Horiz Position: This tells you the horizontal coordinate of the prop relative to upper left corner of 

the animation window. This field can be modified.
Vert Position: This tells you the vertical coordinate of the prop relative to upper left corner of the 

animation window. This field can be modified.
Transition Clicking this button will open the Transition for Prop...   dialog box  .
Convert Click on this button to convert the prop to a CorelMOVE object.
Edit Prop Click on this button to open the Paint Editor in order to edit the currently selected 

prop.
OK button Click OK to accept the prop settings.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Rename Member
The Rename Member dialog box provides a means for you to specify a unique name for the object that 
you are about to rename in the animation object library. Note: all objects in the object library of a 
particular object type must have a unique name before CorelMOVE will store it.

Current Name: This field shows you the name of the object in the animation library which you are 
about to rename.

New Name: This is the field where you type in a unique object name as a new name for the existing
object. When you are satisfied with your entry, you could press ENTER or click OK to 
accept it and proceed with the renaming process.

OK Click OK to save the object under the new name.
Cancel Click Cancel to abandon any changes and close the dialog box.



Rotate By

The Rotate By dialog box allows you to rotate a selected area. If no area has been selected with the 
Marquee or Lasso tool, then the rotation will apply to an entire prop or every cel of an actor.

Degrees The rotation field can have a value of 0 to 180 degrees.
Clockwise Click on this radio button to set a clockwise direction of rotation.
Counter-
clockwise Click on this radio button to set a counter-clockwise direction of rotation.
OK Click OK to rotate the object.
Cancel Click Cancel to abandon any changes and close the dialog box.



Save Animation As
The Save Animation As dialog box allows you to specify a CorelMOVE filename, drive, and directory, so 
that CorelMOVE can properly save it.

File Name: Use the File Name: textbox to specify the filename by directly typing it in and then 
press ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

File Name: Use the entries in the File Name: listbox to specify a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
Save File as Type: Use the Save Files by Type: combo box to change the filename extension pattern 

so that File Name: listbox will only list the filenames of the selected filename 
extension.

Drives: Use the Drives: combo box to change the current drives from a list of available 
drives on the system.

OK Click the OK button to accept the filename, drives, and path that you have just 
specified with the various dialog box controls.

Cancel Click Cancel to abandon the file Save As operation and close the dialog box.



Scale By

The Scale By dialog box allows you to change the vertical and horizontal size of the selected area. If no 
area has been selected with the Marquee or Lasso tool, then the size change will apply to an entire prop 
or every cel of an actor. The Horizontal and Vertical scale fields can have a value of 1 to 200 percent.

%Vertically The change in the objects height.
%Horizontally The change in the objects width.
OK Click OK to scale the object.
Cancel Click Cancel to abandon any changes and close the dialog box.



Scale Path

The Scale Path dialog box allows you to increase or decrease the number of points on the entire path or 
over a selected range of points. The current number of points is displayed, and the number of points the 
path is to be scaled to is entered in the Desired field.



Select an Object to Import
This dialog box allows you to select and import one or more objects from a CorelMOVE (.CMV) or Motion 
Works (.MWF) file.

Select an Actor to Import
Select a Prop to Import
Select a Sound to Import

OK Click the OK button to import the selected objects.
Cancel Click Cancel to abandon the import operation and close the dialog box.



Select an Actor to Import
The Select an Actor to Import dialog box allows you to select and import one or more actors from a 
CorelMOVE (.CMV) or Motion Works (.MWF) file.
Actor list box Use the entries in this listbox to select one or more of the actors from the animation

file.
Information This group box displays information about the last selected actor. Actual Size is 

the horizontal by vertical dimensions of the actor's bounding box, measured in 
pixels. The Number of Cels shows the cel count of the actor and the Size refers to
the storage space (in bytes) taken up by the actor.

Preview Enabling this checkbox allows the selected actor to repeatedly play in the preview 
box.

OK Click the OK button to import the selected actors.
Cancel Click Cancel to abandon the import operation and close the dialog box.



Select a Prop to Import
The Select a Prop to Import dialog box allows you to select and import one or more props from a 
CorelMOVE (.CMV) or Motion Works (.MWF) file.
Prop list box Use the entries in this listbox to select one or more of the props from the animation 

file.
Information This group box displays information about the last selected prop. Actual Size is the

horizontal by vertical dimensions of the prop's bounding box, measured in pixels. 
The Size refers to the storage space (in bytes) taken up by the prop.

Preview Enabling this checkbox displays the selected prop in the preview box.
OK Click the OK button to import the selected props.
Cancel Click Cancel to abandon the import operation and close the dialog box.



Select a Sound to Import
The Select an Sound to Import dialog box allows you to select and import one or more sound files from 
a CorelMOVE (.CMV) or Motion Works (.MWF) file.
Sound list box Use the entries in this listbox to select one or more of the sound files from the 

animation file.
Information This group box displays information about the last selected sound file. Sampling 

Rate, measured in Hertz, is the number of times per second that the sound was 
measured during recording. The Size refers to the storage space (in bytes) taken 
up by the sound file and Length refers to the total playing time.

Preview Enabling this checkbox plays the selected sound file once.
OK Click the OK button to import the selected sound files.
Cancel Click Cancel to abandon the import operation and close the dialog box.



Select an Animation
The Select an Animation dialog box allows you to select one animation from a Motion Works (.MWF) file 
containing multiple animations.
Animations: Use the entries in the listbox to select one of the animations from the Motion Works

file.
OK Click the OK button to open the selected animation.
Cancel Click Cancel to abandon the open file operation and close the dialog box.



Select Name for New File
The Select Name for New File dialog box allows you to specify a CorelMOVE filename (.CMV file), drive 
and directory, so that CorelMOVE can properly create it.

File Name: Use the File Name: textbox to specify the filename by directly typing it in. Press 
ENTER or click OK to accept it. The valid input for this text box could be: 

 a filename with full drive and path specified
 just the drive
 just the path
 both the drive and the path
 or just the filename itself

Use the entries in the listbox under File Name: to select a filename.
Directories: Use the entries in the Directories: listbox to select the current directory.
Save File as Type: Use the Save Files by Type: combo box to change the filename extension pattern 

so that File Name: listbox will only list the filenames of the selected filename 
extension.

Drives: Use the Drives: combo box to change the current drives from a list of available 
drives on the system.

OK Click the OK button to accept the filename, drives, and path that you have just 
specified with the various dialog box controls.

Cancel Click Cancel to abandon the new file operation and close the dialog box.
Read Only Select the Read Only button to guard the file against being overwritten or changed.



Set Size 
The Horizontal and Vertical size of the actor is measured in pixels and must be between 1 and 999.
Reducing the horizontal or vertical size of the actor will crop the image.

OK Click the OK button to accept the size changes.
Cancel Click Cancel to abandon the Page Setup procedure and close the dialog box.



Sound Information
The Sound Information dialog allows you to modify and get information about the various properties and
attributes of the currently selected Sound object.

Name: This indicates the name of the Sound. You can edit this name directly to rename the 
Sound.

Starts At Frame: This tells you what the starting frame is for the Sound. You can modify this field to 
change the start frame of the Sound.

Ends At Frame: This tells you what the ending frame is for the Sound. You can modify this field to 
change the ending frame of the Sound.

Volume: Choose a playback volume level.
Priority: Choose a value between low and high. In an animation with many sounds being 

scheduled to play at one time in a given frame, the higher priority sound will play, and
the lower priority sound may or may not be played. This will guarantee a reasonable 
sound output performance.

Channel This set of three radio buttons in the Channel group allows you to choose which 
channel of a stereo sound you want to use for the presentation. If the sound is not a 
stereo sound, the selection would not make any difference.

Playing Time: This is an information field specifying the length of the sound object in seconds.
Repeat Sound Click to check this box if you want a sound of short duration to repeat itself 

throughout the duration of its scheduled life span as indicated on the timeline.
Convert Click here to convert the sound file to a CorelMOVE wave object.
Edit Sound Click on this button to open the Wave Editor.
OK Click OK when you are done changing any components and attributes of the Sound 

and to ask CorelMOVE to accept the new changes.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Transitions for Prop
The Transition for Prop dialog box allows you to specify the prop's entering and exiting transition effect.

Enter Transition Select an option from this list to change parameters for the prop's entering transition 
effect.

Exit Transition Select an option from this list to change parameters for the prop's exiting transition 
effect.

Steps: Enter a value to specify how many steps the transition should take to completely 
reveal or hide the given prop. This option is not available for all transitions.

Edit Click on Edit to open the Edit Scroll, Edit Zoom or Edit Zoom Rectangles dialog box.
Preview Click Preview to see an example of what the selected transitions will look like.
OK Click OK to accept the selected transition effect and its parameters.
Cancel Click Cancel to abandon any changes you have made and close the dialog box.



Cel Sequencer Roll-Up

Click on the above graphic for information about the Cel Sequencer components.



Control Box
Clicking on the Control Menu box displays commands that allow you to roll-up, roll-down, arrange, and 
close the Roll-Up. See Using Roll-Up windows for more details.



Roll-Up Arrow
Click on this control to either roll-up or roll-down the Cel Sequencer window.



Sequencer Title Bar
The title bar displays the name of the currently selected actor.



Frame number row
Each number in this row represents a single frame from the currently opened animation.



Cel number row
Each number in this row represents a single cel from the currently selected actor.



Cel Size%
Each value in this row indicates the displayed size of an actors cel as a percentage of its normal size.



Frame Slider bar
The frame slider control allows you to quickly move to any frame within the animation.



Sequence Sizing flyout:
This flyout allows you to Select All the cel Size% values and choose from the following types of sizing 
options:

Normal Size - Selected cels are displayed at their normal (100%) size. 

Small to Large - The first cel in the selected range is displayed at 1% of normal size and is 
increased until the size reaches 200% at the end of the range.

Large to Small - Cel size starts at 200% of normal and reduces in size until the last cel in 
the selected frame range reaches 1% of normal size.

Normal to Large - Cel size starts at 100% of full size in the selected frame range and 
increases to 200%.

Large to Normal - Cel size starts at 200% in the selected frame range and decreases until 
it reaches 100%.

Small to Normal - Cel size starts at 1% of full size in the selected frame range and 
increases to 100%.

Normal to Small - Cel size starts at 100% of full size in the selected frame range and 
decreases to 1%.

Constant - Selected cels are displayed the same size as that of the first cel of the selected 
frame range.

First to Last - Cel size starts at the first cel of the selected frame range and increase or 
decrease to the last cel of the selected frame range.

Random - The cels of the selected frame range are shown at various sizes from 1% to 100%
in no particular order.



Sequence Effects flyout
This flyout allows you to Select All the frames and choose from the following types of sequence effects 
options:

Normal Cycle - All of the cels are displayed in their original order starting with the first cel 
of the actor displayed in the first frame of the selected range.

Reverse Cycle - The order of the cels is reversed so that the last cel of the actor is shown in
the first frame of the selected range. The cel numbers decrease as the frame numbers 
increase. The sequence is repeated over the selected range of frames.

Ping Pong - The original order of the cels is used, then the order is reversed. For example, if
you have four cels, the order would be 1, 2, 3, 4, 3, 2, 1, 2, 3, 4, 3, 2 ..., over the selected 
range of frames.

Slow Forward - The cels are shown in the original forward order; however, the same cel is 
repeated over two consecutive frames, e.g., 1,1,2,2,3,3,...in the selected range. This has the
effect of "slowing down" the actor.

Slow Reverse - The cels are shown in the reverse order with the same cel repeated over 
two consecutive frames, e.g., 4,4,3,3,2,2... in the selected range. This has the effect of both 
"slowing down" the actor, and running it in reverse.

Random - The order in which the cels are displayed within the selected range is generated 
randomly.



Cel Sequencing Options
The available cel sequencing options in list box and their examples are (assuming an actor with 4 cels):
1) Normal Cycle

1 2 3 4 1 2 3 4
2) Reverse Cycle

4 3 2 1 4 3 2 1
3) Ping Pong

1 2 3 4 3 2 1 2 3 4 3 2 1
4) Slow Forward

1 1 2 2 3 3 4 4 1 1 2 2 3 3 4 4
5) Slow Reverse

4 4 3 3 2 2 1 1 4 4 3 3 2 2 1 1
6) Slow Ping Pong

1 1 2 2 3 3 4 4 3 3 2 2 1 1 2 2
7) Random

2 4 1 2 4 3 3 1 2 4 1 3 2 2 4 1



Scale Sequence Options
The available cel sizing options in this list box and their examples in percentage are (Assuming an 8 
frame selection):
1) Normal Size

100 100 100 100 100 100 100 100
2) Small To Large

1 29 58 86 115 143 172 200
3) Large To Small

200 172 143 115 86 58 29 1
4) Normal To Large

100 114 128 142 157 171 185 200
5) Large To Normal 

200 186 172 158 143 129 115 100
6) Small To Normal 

1 5 29 43 57 71 85 99
7) Normal To Small

100 86 72 58 44 30 16 2
8) Random

1 56 19 80 58 47 35 89



Library Roll-Up
The Library Roll-Up is used to store and retrieve objects that can be placed in current or future 
CorelMOVE animations. Using the Library Roll-Up to place actors, props, or sounds is faster and easier 
than importing.

Click on any part of the above image to get more information.

To display the Library Roll-Up, choose the Library Roll-Up option under the View menu or click on the 

Library icon  in the Control Panel.



Control Box
Clicking on the Control Menu box displays commands that allow you to roll-up, roll-down, arrange, and 
close the Roll-Up. See Using Roll-Up windows for more details.



Library Name
The name of the library file (.MLB) that is currently open.



Roll-Up Arrow
Click on this control to either roll-up or roll-down the Library window.



Fly-out button
Click on this button to open the Library fly-out menu.



New Library
Choosing the New Library command opens the New Library dialog box which prompts you to enter the 
name, drive, and directory for the new library.



Open Library
Choosing the Open Library command displays the Opens Library dialog box which prompts you to enter 
the name, drive, and directory of the library file (.MLB) to open.



Add Member
Choosing the Add Member command adds the selected actor, prop, or wave to the currently open library.



Delete Member
Choosing the Delete Member command deletes the selected object from the currently open library.



Rename Member
Choosing the Rename Member command opens the Rename Member dialog box.



Visual Mode
Enabling Visual Mode graphically displays each object in the library. If Visual Mode is not enabled, the 
display box shows a list of object icons and names.



Object Name
The name of the library object that is currently selected. All library objects of a particular type have a 
unique name.



Library Scroll Bar
Bars along the bottom or right side of the screen used to view library objects outside the current viewing 
window.

Click on the arrows to move the current view one object in the selected direction.
Click on an elevator to move the view by five objects.
Drag a thumb to move the view an arbitrary amount in any direction.



Play
Click Play to preview sounds or actors. This button toggles between Play and Stop Playing.



Place
Click Place to place actors, props, or sounds in the animation. If you are in Visual Mode, the currently 
displayed object is placed in the animation. If you are not in Visual Mode, select an object with the cursor 
and press place.



Object Preview
This window previews objects in Visual Mode or text mode.



Display Sounds
The Display Sounds button is used to determine if wave objects are shown in the Object Preview window.



Display Props
The Display Props button is used to determine if prop objects are shown in the Object Preview window.



Display Actors
The Display Actors button is used to determine if actor objects are shown in the Object Preview window.



Path Edit Roll-Up
The Path Edit Roll-Up provides tools for editing an actor's entire path or selected range of path points. 
Click on the graphic below for more information.



Control Box
Clicking on the Control Menu box displays commands that allow you to roll-up, roll-down, arrange, and 
close the Path Edit Roll-Up. See Using Roll-Up windows for more details.



Roll-Up Arrow
Click on this control to either roll-up or roll-down the Path Edit window.



Edit Menu Fly-out button
Click on this button to open the fly-out Edit menu.



Undo Path Operation
Choose Undo to reverse any operations that are done to the path.



Cut Point(s)
Choose Cut to cut a series of selected path points onto Windows' Clipboard.



Copy Point(s)
Choose Copy to copy a series of selected path points onto Windows' Clipboard.



Paste Point(s)
Choose Paste to paste a series of path points from Windows' Clipboard to the currently selected object, 
starting at the currently highlighted path point of the object.



Clear Whole Path
Choose Clear Whole Path to remove the entire path. You do not have to select the points, simply click on 
Clear Whole Path and all the points are deleted.



Select All Points
Choose Select All Points to select the entire path. This command is useful if you want to move all of the 
points in the path.



Move Frame With Point
If Move Frame With Point is enabled, the Frame Counter on the Control Panel changes to reflect the 
selected point. The Frame Counter displays the number of the frame that is active when the actor is on 
the selected point.



Allow Adding Points
When Allow Adding Points is enabled, you can click anywhere in the Animation Window and points will be 
added automatically. The newly-added point becomes the selected point and you can continue to add 
new points.



Path Point Information button
Choose the Path Point Information button to get the Point Information dialog box.



Flip Path Vertical
Click on the Flip Path Horizontal button to flip the entire path or a selected range of points from top to 
bottom.



Flip Path Horizontal
Click on the Flip Path Horizontal button to flip the entire path or a selected range of points from right to 
left.



Path Points Smoothing button
Click the Path Points Smoothing button to make the selected points or path less angular and more fluid. 
Each time you click the button the path becomes smoother; and if used repetitively, the entire path or the 
selected points become progressively flatter.



Scale Path
Choose the Scale Path icon to display the Scale Path dialog box which allows you to set a desired 
number of path points to scale the path to.



Path Points Distribution button
Click the Path Points Distribution button to equalize the distance between points on the entire path or over
the selected range of points.



Timeline Roll-Up
Timelines provide a dynamic view of all the objects within the animation. An object's information can be 
accessed and manipulated from within the Timelines Roll-Up. Click on the graphic below for more 
information.



Control Box
Clicking on the Control Menu box displays commands that allow you to roll-up, roll-down, arrange, and 
close the Timelines Roll-Up. See Using Roll-Up windows for more details.



Roll-Up Arrow
Click on this control to either roll-up or roll-down the Timelines window.



Resize Button
Click on this button to resize the Timelines window.



Actor Icon
When this icon is selected, all the objects in the actor category appear in the Timelines window. If you 
click the icon to deselect it, all the objects in the actor category are temporarily hidden from the list.



Prop Icon
When this icon is selected, all the objects in the prop category appear in the Timelines window. If you click
the icon to deselect it, all the objects in the prop category are temporarily hidden from the list.



Sound Icon
When this icon is selected, all the objects in the Sound category appear in the Timelines window. If you 
click the icon to deselect it, all the objects in the Sound category are temporarily hidden from the list.



Cue Icon
When this icon is selected, all the objects in the Cue category appear in the Timelines window. If you click
the icon to deselect it, all the objects in the Cue category are temporarily hidden from the list.



Scale Area
This scale marks the length (in frames) of the portion of the animation in the Timelines Roll-Up. The scale 
will vary depending on what percentage of the animation is visible. The amount visible is set by the Zoom 
Slider.



Zoom Slider 
The Zoom slider control enables you to see more or less of the timelines. The percentage indicated 
beside the slider shows how much of the animation is visible. The lower the percentage, the more visible 
the timeline detail. The higher the percentage, the more you'll see of the object timelines.



Play Indicator
The Play Indicator is a visual cue to the approximate position of the current frame.



Display Object Toggle
The checkbox to the left of each object's descriptive icon allows you to turn that object off and on. This 
makes work on complex animations easier by temporarily removing objects from the screen.



Object Type Icon
The icon indicates what type of object it is.

For example:
is an actor,
is a prop,
is a sound,
is a cue.



Object Name
This is the name of the object assigned during its creation, or import.

Simply clicking on the object's name will select the object (the object is highlighted) and double-clicking 
on the object name will call up the object's Information dialog box.

If you drag the highlighted entry up or down the Timeline and release, you can promote or demote the 
object's placement order (farther or closer from the front) relative to other objects of the same type.



Object Timeline
Each object's timeline is a visual representation of the entry frame, the length of the object's play through 
the animation and the frame at which it exits.

More information is available on:
Adjusting an object's start frame
Moving a whole timeline



To adjust an object's start frame:
1. Move the cursor near the start frame handle on the object's timeline.

The cursor changes to a one-directional arrow when it is over the start frame handle.

2. Drag the handle to a new start frame.
The object's start frame number at the bottom of the window changes as you drag the handle 
horizontally along the frame counter.

3. Release the handle when the Start Frame number appears at the frame you want.
The object's timeline is updated to reflect the changes to the start frame number.

You can adjust the End Frame for the object using the same technique as described for the Start Frame.



To move a whole timeline:
1. Move the cursor near the middle of the timeline.

The cursor changes to a two-directional arrow.

2. Click and drag the timeline to a new position.
The object's start and end frame numbers at the bottom of the window change as you drag the line 
horizontally.

3. Release the line when you are satisfied with its new position.
The object's timeline is updated to reflect the changes to the start frame and end frame numbers.



Vertical Scroll Bar
If there are more objects in the animation than the Timelines window can display, click on the Vertical 
Scroll Bar to view the other objects.



Horizontal Scroll Bar
Click on the Horizontal Scroll Bar to scroll to see more of the Timelines that are covered by the edge of 
the window. To view the entire timeline, drag the zoom slider to the right until it displays 100%.



Status Area 
These two fields display the Start and End frame of the selected object.



Current Frame Number
This field displays the number of the current frame.





Get Started with CorelMOVE

OVERVIEW
Creating a new animation
Opening an animation
Saving a new animation
Choosing commands
Choosing Tools
Using the Animation Window
Working with dialog boxes
Using Roll-Up windows
Starting and exiting CorelMOVE



Overview
As with other Windows applications, you work with CorelMOVE by choosing commands from menus and 
making selections in dialog boxes. Most of the remaining interaction involves using tools on the left side of
the screen. What remains are the controls common to all Windows applications: scroll bars, the window 
border, the minimize and maximize buttons and so on. To learn about these controls and the CorelMOVE 
screen, see The CorelMOVE Screen.

Each animation is composed of one or more frames (you can add more using the Animation Information 
dialog box). A frame is represented on the screen by a rectangle with a light gray border. Anything you 
place on the area surrounding the frame is saved but is not visible during playback. The Animation 
Information dialog box also lets you set the dimensions of the animation frame.

As you become more familiar with CorelMOVE, you'll discover that there's often more than one way to 
perform a specific task. When selecting actors, for example, you have the choice of using the pick tool or 
the path tool to make a selection in the Animation window or the Timeline Roll-Up.



Creating a new animation
1. Choose New from the File menu. The Select Name for New File dialog box is displayed.
2. Enter the name of the new animation in the File Name field.
3. Select a drive and directory if the location of the new animation is to be different from 

that currently displayed.



Opening an animation
1. Choose Open from the File menu. The Open dialog box is displayed. 
2. Double click on the animation filename.

If the animation is in a different location, select the drive and directory. You can open 
either CorelMOVE files (.CMV) or ProMotion files (.MWF).

Note:    Previously opened animation files appear at the bottom of the File menu. Up to 
four can be displayed. Click on one of the names to open the file.



Saving an new animation
1. Choose Save from the File menu.

The animation is saved. If you wish to save the animation in a different location or 
under a different name, select the Save As command from the File menu.



Choosing commands
Menu bar:
The menu bar contains the names of the six drop-down menus. Click on a menu name with the mouse    A
list of commands is displayed.

To choose a menu command with the mouse:
1. Click with the menu name with the left mouse button.
2. Click the command with the left mouse button.

To choose a menu command by pressing keys:
1. Press the ALT key.
2. Press the underlined letter in the name of the menu.
3. Press the underlined letter in the name of the command.

To close a menu without choosing a command:
Move the mouse pointer away from the menu and click with the left mouse button or 
press Esc.



Using the Animation Window
When you create or edit an animation, the Animation window is displayed. This window is the area you 
use to build your animation. The default size of the animation window is 480 x 360. When you place an 
object on the Animation window, it is placed on the current frame.



Choosing Tools
The toolbox gives you quick access to the most common operations in CorelMOVE. 

To choose a Tool with the mouse:
Click the tool with the left mouse button.



Pick Tool

Path Tool

Actor Icon

Prop Icon

Sound Icon

Cue Tool



Working with dialog boxes
When CorelMOVE requires information to carry out a command, it displays a dialog box.

To set options in a dialog box:
Do one of the following:

· Click on the option with the left mouse button.
· Hold down the ALT key and press the underlined character in the option name.

To select an item in a list box:
Do one of the following:

· Click the scroll arrows to display the option you want, then click on it with the left 
mouse button.

· Hold down the ALT key, press the underlined character in the list name, press  or ¯ to
highlight the option you want.

To select an item in a drop-down list box:
Do one of the following:

· Click the down arrow, then click on the option with the left mouse button.

· Hold down the ALT key, press the underlined character in the list name, release the ALT
key, then press  or ¯ to highlight the option you want.

To type in a text box:
If the box is empty, do one of the following:

· Click on the text box and begin typing.
· Hold down the ALT key, press the underlined letter in the text box label, then begin 

typing.

If the box contains text do one of the following:
· Hold down the left mouse button, move the mouse pointer over the text you want to

replace, then start typing.
· Hold down the ALT key, press the underlined letter in the text box label, then begin 

typing.

To edit a text box:
Do any of the following:

To Do this
Move insertion point Click on the new location, or press the 

®, ¬, HOME or END key.
Select text Drag with the mouse, or hold down the 

SHIFT key and press the ®, ¬, HOME or 
END key.

Delete text Press the BACKSPACE or DEL key to 
delete one character at a time or select 
the characters and press the DEL key. 

Replace text Select text and begin typing.

To carry out the options you set:



Choose OK or press the ENTER key.

To close a dialog box without carrying out the options you set:
· Choose Cancel or press the Esc key.



Using Roll-Up windows
Roll-Up windows contain many of the controls found in dialog boxes: command buttons, text boxes, drop-
down list boxes and so on. But unlike most dialog boxes, the roll-up stays open after you apply the 
selected options. This lets you make adjustments and experiment with different options without having to 
continually re-open a dialog box. When you are not using a roll-up, you can hide the controls leaving just 
the Title bar visible.

To carry out your selections:
Click Apply.

To roll a window up and down:
Do one of the following:

· Click the arrow in the top right corner.

· Click  and choose Roll up or Roll down.

To close a Roll-Up window:
Do one of the following:

· Click  and choose Close.
· Click in the window and press the Esc key.

To move a Roll-Up window:
· Click on the Title bar, hold the left mouse button down, and move to the new location.

To arrange open Roll-Up windows:
1. Click 

2. Do one of the following:
· Choose Arrange to roll-up the active window and move it to the top right corner of 

the drawing window.
· Choose Arrange All to roll-up all open windows and move some to the top right 

corner and others to the top left corner of the drawing window.

To get Help on Roll-Up windows:
Do one of the following:

· Press SHIFT+F1 and click on the Roll-Up.

· Click  and choose Help.



Starting and Exiting CorelMOVE

Starting CorelMOVE:
Double click on the CorelMOVE icon. The CorelMOVE screen is displayed. Only the File menu is initially 
available. The rest of the menus are dimmed and are not accessible until you have either opened or 
created an animation.

Exiting CorelMOVE
To exit CorelMOVE, select Exit from the File menu. You are prompted to save the animation before 
quitting if you have not saved the current changes.





View Animations

Playing an Animation
Stopping an Animation
Displaying and hiding objects
Changing the Playback Speed (frame rate)



Playing an animation
To play an animation, use the Control Panel. Its controls are similar to a videotape player's. The controls 
are as follows:
 
Frame Counter 
The Frame Counter displays the current frame number. When an animation is playing, the Frame Counter
increments one frame at a time until the end of the animation. If you press Stop, the Frame Counter 
stops. Use the Frame Counter slider to change the current frame number of the animation.

Sound on/off
Toggle the Sound button to turn the sound speaker on or off. The sound is on when the button is 
depressed.

Loop Animation
Click this icon to play the animation continuously from start to end. The animation will play from start to 
end when the button is depressed.

Play Reverse
Click this button to play the animation in reverse.
 
Stop Animation
Click this button to stop the animation. Or, press the Esc key to stop the animation.

Play Forward
Click this button to play the animation forward.

Step Frame Reverse
Click this button to step the animation one frame in reverse. To step backwards through the frames 
continuously, click this button and hold down the mouse button.

Step Frame Forward
Click this button to step the animation one frame forward. To step forward through the frames 
continuously, click this button and hold down the mouse button.

Rewind To Start
Click this button to reset the animation play position to frame one (the beginning).

Fast Forward to End
Click this button to reset the animation play position to the last frame (the end).

Note:
When an object is selected, it is identified in the Status Line above the Frame Counter slider. Its start and 
end frames are indicated by the up- and down-pointing arrows to the right of the slider, respectively.



Stopping an Animation

To stop an animation, click the Stop Animation button ( ) in the Control Panel or press the Esc key. An 
animation can also be stopped by a Mouse Button Click or Ctrl-Break if either of these Stop Animation 
On options have been enabled in the Playback Options section of the Preferences dialog box dialog box.



Displaying and Hiding Objects in the Timelines Window

Temporarily hiding objects in the Timelines Window makes working with complex animations easier. To 
display and hide objects in the Timelines Window, use the check boxes to the left of each object's 
descriptive icon. By default, a check mark appears in the check box, indicating that the object is displayed
in the Animation window.

To hide an object:
Disable the check box by clicking in it. The check mark disappears and the object is 
hidden.

To display a hidden object:
Enable the check box by clicking in it. A check mark appears in the check box and 
the object is displayed.



Changing the Playback Speed

The animation playback speed is measured in frames per second (fps). The available speeds range from 
1 to 18 fps. The animation speed varies from one system to another; it depends on the amount of 
available RAM, the processor, and the access time of the hard disk. 

To change the playback speed:
1. Choose Animation Info from the Display menu.
2. Enter a speed in frames per second in the Speed box.



Create Animation Objects

Creating Single-Cel Actors
Creating a New Actor
Creating a New Actor from a File

Creating Multiple Cel Actors
Overview
Inserting cels
Morphing cels
Removing cels
Moving through the cels of an actor

Placing Actors on Stage
Using the Pick Tool
Using the Actor Information dialog box
Moving an actor with the Actor Information dialog box

Creating Paths
Creating Props

Creating a prop
Creating a prop from a file

Placing Props on Stage
Using the Pick Tool
Using the Prop Information dialog box
Moving a Prop with the Prop Information dialog box

Creating Actors & Props in CorelDRAW
Creating Waves
Using Libraries

Overview
Creating a New Library
Adding an Actor, Prop or Wave to a Library
Loading a Library
Deleting an Actor, Prop or Wave
Renaming an Actor, Prop or Wave

Creating Cues



Creating a Single-Cel Actor

To create a new actor: 
1. Click the Actor icon on the toolbox. The New Actor dialog box is displayed.
2. Enter a name for the new actor in the Object Name box.

Each actor should have an individual name to identify it. This is because as you create 
or import actors into your animation, they are added to the list of objects in the 
animation. This list is found in the Timelines Roll-Up.

3. Click Create New. 
4. Enter the name of the application to be used in the Object type box.

If the application is not CorelMOVE, the editing application opens. For example, 
CorelDRAW would open if it was selected. You would then create the object in the 
opened application. When it is saved, the application closes, CorelMOVE is opened and 
the actor is placed in CorelMOVE.
The Result section of the dialog box displays the results of each selection you have 
made in the Object Type box.

5. Click OK.
6. Use the tools in the Paint Palette to draw the actor, or use the tools provided in the 

editing application.
7. Choose Apply Changes from the File menu and then choose Exit. If you are in another 

application, exit and you are returned to CorelMOVE.



Creating a Single-Cel Actor from a File

To create a new actor from a file:
1. Open the New Actor dialog box.
2. Enter a name in the Object Name box.
3. Click Create from File.
4. Enter the name of a file in the File box. 
4. Click OK.
5. Use the tools in the Paint Palette to draw the actor or use the tools provided in the 

editing application. 
6. Choose Apply Changes from the File menu and then choose Exit. If you are in another 

application, exit and you are returned to CorelMOVE.
7. Click Save.



Overview
Multiple-cel actors are created using the same commands as single-cel actors. Once you are in the Paint 
window, you can insert cels to create a multiple-cel actor.

Inserting and removing cels
The actor's cycle speed depends on the number of cels and the actor's size in each cel. The cycle speed 
is the flow or smoothness of movement and the speed at which the actor moves through the entire 
number of cels. A high number of cels causes the actor's speed to decrease, because the actor's position 
changes little in each cel and it takes longer to cycle through all of the cels. If you want to make an actor 
move more rapidly and more abruptly, lower the number of cels.



Inserting cels
You can insert one or more cels in an actor using the Insert Cels command in the Paint window's Edit 
menu. The best performance requires a maximum of 10 cels per actor; however if you have large 
amounts of memory available, this maximum can be increased proportionally to the memory available.

To insert cels in an actor: 
1. Select Insert Cel from the Edit menu.

The Insert Cels dialog box is displayed.
2. Type in the number of cels to insert. The default is 1.

If you want the new cels to have the same image as the current cel, click the Duplicate
Contents check box, then click OK.

3. Select the insert position for the new cels. Click Before Current to insert the cel(s) 
before the currently displayed cel; click After Current to insert the cel(s) after.

When cels are inserted into an actor, the Paint window appears blank unless you have chosen to 
duplicate the cel contents. The cel count changes to reflect the number of cels added to the actor.



Morphing cels
You can morph between two existing cels in a multiple-cel actor using the Morph Cel 
command.
To create a morphing effect between two cels: 

1. Load a new or existing actor into the paint edit window
2. Use the cel selector to choose the preceding cel of the two you intend to morph.
3. In the first cel, create the actor that you want to appear at the beginning of the 

morphing sequence.
You can use the tools in the Paint Palette, or import an image into the cel using File - 
Import Cel. You can also drag-and-drop an image into the cel from CorelPHOTO-PAINT.

4. Switch to the second cel and repeat step 3 for the actor that you want to appear at the 
end of the morphing sequence.

5. Switch back to the preceding cel and choose Morph Cel from the Effects menu.
The Morph dialog box opens, with the From and To cels displayed in separate fields.

6. Using the Pick tool, click in either the From or To field.
A red point will appear in each. This is the first of the control points you will create. 
These are matched pairs of points and they determine how the morphing will proceed. 
As you create additional points, the currently-active pair will be shown in red and the 
others will be green.
You can zoom in by selecting the  and clicking on the image with the left mouse 
button. Use the right mouse to zoom out.

7. Use the Pick tool  to move these points around anywhere in the image fields.
During the morphing, the intermediate image stages created will show changes in 
relation and with respect to these points.
To remove a point, click on it with the right mouse button. Use the Clear button if you 
want to remove all points currently created.

8. Set the number of cels you want to use to perform the morphing in the Cels to Create
field.
The maximum valued allowed here is 200.
9. Click OK to begin morphing the cels.
10. When the morphing is completed, choose Apply Changes from the File menu to 
finalize the process.



Removing cels
You can remove cels from an actor using the Remove Cels command under the Edit menu. 

To remove cels from an actor:
1. Select Remove Cels from the Edit menu. The Delete Cels dialog box opens.
2. Enter the number of cels to remove.



Moving through the cels of an actor 
You can use the Cel Cycle scroll bar on the Paint Palette to move through the cels of an actor, or display 
the cel you want to edit or create. You can also get an idea of the how the actor moves and what it will 
look like in the animation. The Cel Counter displays the cel currently shown and total number of cels for 
the actor. You can display the next cel by clicking once on the arrows. If you want to cycle through the 
cels more quickly, hold the mouse button down or move the scroll bar.



Placing Actors on Stage Using the Pick tool

The Pick tool allows you to move and actors to any location on the Animation window. 

To move an object with the pick tool:
1. Select the Pick tool and click on the actor you want to move. The object displays a 

marquee border and the cursor changes to the move cursor.
2. Drag to the desired location.
3. Release the mouse when the object is positioned correctly.



Placing Actors on Stage Using the Actor Information dialog box
You can enter the position of an actor in the Actor Information dialog box. To display the Actor Information 
dialog box, double-click on a placed actor, double click on an actor in the Timeline Roll-Up, or select an 
actor in the Animation window and choose Object Info from the Edit menu. The Horizontal and Vertical 
fields show the position of the registration point of the actor in pixels. When you move an actor, the 
numbers in these fields change to reflect the new vertical and horizontal position.



Moving Actors with the Actor Information dialog box
Enter numbers in the Horizontal and Vertical boxes of the Information dialog box. The default Animation 
window size is 480 by 360 pixels. You can enter any value in the fields as long as it does not exceed the 
size of the Animation window.



Creating Paths
When an actor is placed in an animation, it is positioned at a specific location on the screen and given a 
one-point path. 

To add points to an actor's path:
1. With an actor selected, choose the Path tool on the toolbox. The Path Edit Roll-Up 

appears. 
2. Make sure that the Allow Adding Nodes check box is enabled, then using the mouse, 

click a number of new points. 
The points of the path are displayed as black hollow rectangles if they are deselected. 
If selected, the rectangles are filled. The first point in a path is a slightly larger 
rectangle than the rest and the last point is displayed as a circle
When the animation is played back, the actor animates or moves along the points on 
the path.

The actor's speed is dependent upon the distance between the path points. The closer together the points
are, the slower the actor moves; the further apart the points are, the faster the actor moves.



Creating a prop

To create a new prop: 
1. Click the Prop icon on the toolbox or choose Prop from the Insert New Object flyout 

under the Edit menu. 
The New Prop dialog box is displayed.

2. Enter a name for the new prop in the Object Name box.
Each prop should have an individual name to identify it. This is because as you create 
or import props into your animation, they are added to the list of objects in the 
animation. This list is found in the Timelines Roll-Up.

3. Click Create New. 
4. Enter the name of the application to be used in the Object type box. 

If the application is not CorelMOVE, the editing application opens. For example, 
CorelDRAW would open if it was selected. You would then create the object in the 
opened application. When it is saved, the application closes, CorelMOVE is opened and 
the prop is placed in CorelMOVE. 
The Result section of the dialog box displays the results of each selection you have 
made in the Object Type box.

5. Click OK.
6. Use the tools in the Paint Palette to draw the prop, or use the tools provided in the 

editing application.
7. Choose Apply Changes from the File menu and then choose Exit. If you are in another 

application, exit and you are returned to CorelMOVE.



Creating a prop from a file
To create a new prop from a file:

1. Open the New Prop dialog box.
2. Enter a name in the Object Name box.
3. Click Create from File.
4. Enter the name of a file in the File box. 
5. Click OK.
6. Use the tools in the Paint Palette to draw the prop or use the tools provided in the 

editing application. 
7. Choose Apply Changes from the File menu and then choose Exit. If you are in another 

application, exit and you are returned to CorelMOVE.



Placing Props Using the Pick Tool
Using the pick tool
The Pick tool allows you to move props to any location on the Animation window. 

To move an object with the pick tool:
1. Select the Pick tool and click on the prop you want to move. The object displays a 

marquee border and the cursor changes to the move cursor.
2. Drag to the desired location.
3. Release the mouse when the object is positioned correctly.



Placing Props Using the Prop Information dialog boxes
You can enter the position of an prop in the Prop Information dialog box. To display the Prop Information 
dialog box, double-click on a placed object, double click on an object in the Timeline Roll-Up, or select an 
object in the Animation window and choose Object Info from the Edit menu. The Horizontal and Vertical 
fields show the position (in pixels) of the top left corner of the prop bounding box. When you move an 
actor, the numbers in these fields change to reflect the new vertical and horizontal position.



Moving Props with the Prop Information dialog box
Enter numbers in the Horizontal and Vertical boxes of the Information dialog box. The default Animation 
window size is 480 by 360 pixels. You can enter any value in the fields as long as it does not exceed the 
size of the Animation window.



Creating Actors and Props in CorelDRAW
To create an actor or prop in CorelDRAW:

1. Choose Insert New Object under the Edit menu in CorelMOVE.
2. Choose Actor or Prop from the flyout. The New Actor or New Prop dialog box opens.
3. Enter a name for the new object in the Object Name box.
4. Click Create New.
5. Choose CorelDRAW 4.0 Graphic from the drop-down list.
6. Click OK. CorelDRAW opens.
7. Create the actor or prop.
8. Choose Exit and Return under the File menu. CorelDRAW closes and CorelMOVE opens. 

The object is placed in your animation.



Creating Waves
CorelMOVE lets you record sounds, provided you have a microphone and sound capturing hardware, 
such as the SoundBlaster, Windows Sound System or similar board.

To create a new sound file: 
1. Choose Sound from the Insert Object flyout on the Edit menu.

The New Wave dialog box opens.
2. Enter a name for the new sound in the Object Name box.
3. Click Create New.
4. Select CorelMOVE 5.0 as the object type and click OK.

The Wave Editor opens.

5. Click  to start recording a new sound. 

6. Click  to stop recording the sound.
You can zoom in on the sound wave using the Zoom bar. 
7. Click  to hear your new sound.



If you select an object type other than CorelMOVE, then the sound editing application opens.
For example, if you selected Sound as the object type, an application such as Wave Edit 
would open. When the newly created object is saved, Wave Edit would close, and you would 
be returned to CorelMOVE.



Overview
You can use the Library Roll-Up to create libraries for the actors, props, and sounds that you create or 
import. Load the library which has the object you want to use and use the scroll bars to scroll through the 
object names in the library. Click on the one you want and then select Place on the bottom of the Roll-Up. 
The object is placed in the current animation. If you are not sure which object you want to use, choose 
Visual Mode on the Library Roll-Up flyout, and scroll through the objects using the scroll arrows. You will 
be able to see the actors, props and sound waves before you decide to place them in the animation. You 
can also see an actor cycle through its cels and hear the sounds in the library by clicking Play on the Roll-
Up.



Creating a New Library
To create a library, choose the New command on the Library flyout and enter a name in the New Library 
dialog box.



Adding an actor, prop or wave to a library
To add an actor, prop, or wave to the library, select an object and click on the menu arrow. Choose Add 
Member to Library. The object is inserted in alphabetical order in the library file. If you are adding a wave 
file to a library, you will have to use the Timelines Roll-Up to select it.



Loading a library
To load a library, choose the Open command on the flyout menu. The Load Library dialog box opens. 
Select the name of the library you want to open.



Deleting an actor, prop or wave from a library
To delete a actor, prop, or wave, click on the object in the Library Roll-Up and choose Delete Member on 
the Library flyout.



Renaming an actor, prop or wave
To rename an actor, prop, or wave, click on the object in the Library Roll-Up and choose Rename Member
on the flyout. The Rename Member dialog box opens. Enter the new name in the New Name box.



Creating Cues
Add cues to control the playback of the animation. The cue mechanism establishes a condition that must 
be met, then sets an action to take place when this condition is met. To help you create cues, CorelMOVE
provides you with a dialog box that lists the cue choices.

To add a cue to your animation:
1. Click the Cue tool on the toolbox. The Cue Information dialog box appears. 
2. Enter a name for the cue in the Name field.
3. Enter frame numbers in the Enters At Frame and Exits At Frame fields to indicate the 

period in which the cue is active.
4. Select a condition. This sets the condition that causes the action.
5. From the Action drop-down list box, choose an action and select Insert.

The command you choose results in a specific action whenever the specified condition 
occurs. See Action field on the Cue Information dialog box.

See also:
Condition field in the Cue Information dialog box
First Drop-Down List Options
Second Drop-Down List Options
Action field in the Cue Information dialog box



Condition field in the Cue Information dialog
The Condition field provides you with a simple way to set conditions for cues in your animation. All the 
conditions are accessed by clicking on buttons which display the four drop-down list boxes in the 
Condition field. The first button is the only one that is always visible. The last three become visible when 
you select the appropriate condition in the first drop-down list box. 



First Drop-Down List Options
Always - No condition needs to be met and no further information is requested. The 

cue is always executed. 
Pause until/for - The animation stops until the cue is executed. When you choose 

Pause until/for, the second two buttons appear. You can specify the conditions in the
second drop-down list. The options are Time Delay, Mouse Click On, and Key Down. 
These choices allow you to set the type of event that the cue waits for before 
executing the action.

If/After - The cue executes only if the condition that you set is met. If the condition is 
not met, nothing occurs. You can choose from the same conditions in the second 
drop-down list as Pause until/for.



Second Drop-Down List Options
The second drop-down list is displayed only when either Pause until/for or If/After is chosen from the first 
drop-down list. These options set the first part of the condition for the cue. They are:

time delay of - The condition set is a specific time. The third button displays 0.0 
seconds. When you click it, it displays a field in which you can enter a time value 
down to one-hundredths of a second, such as 6.16 seconds. The maximum value is 
600.0 seconds. 

mouse Click On - The condition is a mouse click. The third drop-down list provides the
location of the mouse click. It can be an actor, a prop, or a mouse click anywhere. If 
you select actor or a prop, a fourth drop-down list is displayed which lists actors or 
props in the animation. Select the one you want to click on for your cue.    

key down - The cue condition is the pressing of a selected key. The third drop-down 
list allows you to enter the key that the viewer has to press. The Choose A Key 
dialog box is displayed. Type a character on the keyboard.



Action field on the Cue Information dialog
The Action follows the successful meeting of a cue's condition. Select the option from the drop-down list 
that appears when you click and hold on the currently-displayed action. Highlight the Action you want and 
then click Insert. If you want to remove an action, select it and click Delete. The Action drop-down menu 
list displays the following options:

Continue - The animation continues to run. 
Goto frame - This action causes the animation to jump to a specific frame number. 

You can use this to create loops in an animation. Click on the displayed frame 
number to change it.

Pause until above condition occurs again - The animation pauses until the 
condition statement becomes true again. For example, you could create a cue that 
pauses the animation until you click on a prop. If the prop is not clicked, the 
animation remains paused. 

End animation - The animation stops. If you are executing a stand-alone animation 
using the supplied animation player, then the application quits. 

Change frame rate to - A field appears enabling you to enter a new frame rate for 
the animation. This allows you to make different parts of your animation play at 
different speeds.

Play a sound - A drop-down list appears enabling you to select any of the sound files 
that are currently part of the animation. The selected sound file will begin to play 
when the cue's condition is met.

Stop a Sound - A drop-down list appears enabling you to select any of the sound files 
that are currently part of the animation. The selected sound file will stop playing 
when the cue's condition is met. If the sound is not playing when the cue's condition
is met, nothing happens.

Execute cue - A drop-down list appears enabling you to select any of the cues that are 
currently part of the animation. The selected cue will execute when the cue's 
condition is met.



Condition Options

First List Second List Third List
Always

Pause until/for time delay of Specify a time (0 to 
600 sec.)

mouse click on anything
actor named
prop named

key down Choose a key

If/After time delay of Specify a time (0 to 
600 sec.)

mouse click on anything
actor named
prop named

Key Down Choose a key



Select Animations Objects
When you select an animation object, a highlighting box appears around it, indicating that it is selected. 
The highlighting box disappears when you deselect it. To select and deselect animation objects, use the 
Pick tool or the Timeline Roll-Up.

To Select an Animation Object
Click the animation object with the Pick tool. 
OR
Click the animation object's name in the Timeline Roll-Up.

To Select Multiple Animation Objects
Hold down the Shift key and click two or more objects.
OR
Hold down the Shift key and click two or more object names in the Timeline Roll-Up.

To Deselect Animation Objects
Click the Pick tool anywhere outside the selected object's highlighting box.



Move, Copy and Delete Animation Objects

Moving Objects with Numeric Precision
Moving Objects using the Mouse
Arranging Objects
Copying an Object using the Duplicate Command
Using the Clipboard to Copy an Object
Deleting Objects



Moving animation objects with numeric precision
To move an animation object with numeric precision, use the Actor or Prop Information dialog box. The 
Information dialog box has Horizontal and Vertical fields that show the location of an actor with respect to 
the 0,0 point of the Animation window. (The upper left corner of the Animation window is the 0,0 point.) 

1. Double-click a placed object. The Prop or Actor Information dialog box opens. 
2. Enter a value into the Horizontal field to change the horizontal position of the object. 
3. Enter a value into the Vertical field to change the vertical position of the object.



Moving animation objects using the mouse

1. Click on the actor or prop you want to move. The object becomes selected and the 
cursor changes to the move cursor.

2. Drag to the desired location.
3. Release the mouse button when the object is positioned correctly.



Arranging Objects

Actors and props are placed in an Animation on their own layer. Actors are always placed in front of 
props. If you need to change the layer on which prop or actor is located, use the commands found on the 
Arrange menu. The Arrange commands do not work in the Paint window.

To Front
Select an actor or prop, then choose To Front to move the object's layer to the top.

To Back
Select an actor or prop object, then choose To Back to move the object's layer to the 
bottom.

Forward One
Select an actor or prop, then choose Forward One to move the object's layer one 
position higher. Keep using the command until the object is at the level that you want. 
If the object is on the top layer, the command has no effect.

Backward One
Select an actor or prop, then choose Backward One to move the object's layer one 
position lower in the stack, relative to the other objects in the animation. Use the 
command until the object is at the level you want. If the object is on the bottom layer, 
the command has no effect.



Copying an Object using the Duplicate Command
You can create a copy of a selected object by using the Duplicate command on the Edit menu. The 
Duplicate dialog box appears. Enter the name of the duplicate object in the To: field. The duplicate is 
placed on top of the original, offset slightly down and to the right. It is added to the list in the Timelines 
window. 



Using the Clipboard to Copy an Object
You can cut, copy, and paste actors and props in your animation using the commands under the Edit 
menu in the Animation window. When the object has been cut or copied, it is placed on the clipboard until 
you paste it in the animation. 

To cut objects:
Select the object you want to cut, choose Cut under the Edit menu. The objects are 
removed from the Animation window and the Timelines Roll-Up. Use Paste to place the 
objects back into the animation. You can use the Shift key to select multiple objects.

To copy objects:
Select the object you want to copy, choose Copy under the Edit Menu. Use Paste to 
place the object in the Animation window. You can use the Shift key to select multiple 
objects.

To Paste objects:
Select Paste to place objects that you have cut or copied into your animation. The 
objects are placed on the current frame of the animation and continue until the last 
frame.



Deleting objects
To delete an object, select it and then press the Del key. The object is removed from the Animation 
window, but not from the library.



Editing Animation Objects
To edit an actor/prop: 

1. Double click on the actor in the Animation Window. 
The Actor Information dialog box is displayed.

2. Click on the Edit Actor button. The Paint Edit Window opens or if the application used to
create the object was not CorelMOVE, the editing application opens.

3. Edit the actor using the tools in the Paint Palette to draw the prop, or use the tools 
provided in the editing application.

4. Choose Save from the File menu to save the actor/prop or click the window's Close box 
when you have completed the image. If you are in another application, exit and you 
are returned to CorelMOVE.

To edit a sound: 
1. Double click on the sound icon in the Timelines Roll-Up. 

The Sound Information dialog box is displayed.
2. Click on the Edit Sound button. The Wave Editor Window opens or if the application 

used to create the object was not CorelMOVE, the editing application opens.
3. Edit the actor using the tools in the Wave Editor, or use the tools provided in the 

editing application.
4. Choose Save from the File menu to save the sound. If you are in another application, 

exit and you are returned to CorelMOVE.



Using the Cel Sequencer
Overview
How to Access
Setting Cel to Frame
Setting an Effect on a Range of Cels
Setting Cel Size
Setting Cel Size Range



Overview of the Cel Sequencer
The Cel Sequencer allows you to select which cel of an actor will appear on any given frame, as well as 
its size.

In its default mode, the Path tool cycles the cels of an actor over a series of path points. For example, an 
actor with four cels automatically has its first cel re-assigned to the fifth path point after its first cycle and 
so on.

Frame 1 2 3 4 5 6 7 8
Cel 1 2 3 4 1 2 3 4
Size % 100 100 100 100 100 100 100 100

This sequence gives a steady rhythm and repetition to the actor's movements. When an animation calls 
for irregular rhythms, you can achieve this by repeating a cel over several path points, reversing the cel 
cycle, or skipping cels in the cycle. For example, when animating an actor with four cels, you might have 
the actor remain motionless over several path points or move in reverse. You might also have the actor 
shrink in size over several path points to give the impression that it is traveling away from the viewer.

Frame 1 2 3 4 5 6 7 8
Cel 1 1 3 2 1 2 2 4
Size % 100 100 80 70 60 50 50 40



How to Access

To open the Cel Sequencer:
1. Select an actor.

2. Click the  icon on the Control Panel or select Cel Sequencer Roll-Up from the 
Display menu.



How to Access

To open the Cel Sequencer:
1. Select an actor.

2. Click the  icon on the Control Panel or select Cel Sequencer Roll-Up from the 
Display menu.



Setting Cel to Frame
To set a specific cel to show on a frame

1. Select an actor.
2. Open the Cel Sequencer.
3. Locate the desired frame in the cel sequencer.

Use the slider control at the bottom of the roll-up to move to the frame number you 
want to edit.

4. Change the cel number by double-clicking on the existing cel value and then entering 
the desired cel number.



Setting an Effect on a Range of Cels
To use a cel sequence effect on a range of cels:

1. Select an actor.
2. Open the Cel Sequencer.
3. Select the range of frames you want to apply a sequencing effect to in the Cel 

Sequencer by clicking on one cel, holding down the Shift key, then clicking on another 
cel.
Use the frame slider control if necessary to locate the second cel to click on. If you 
want to select all frames, click on the Sequence Effects Options flyout and then choose
Select All.

4. Choose a cel sequence effect from the Sequence Effect flyout.



Normal Cycle - All of the cels are displayed in their original order starting with the first cel 
of the actor displayed in the first frame of the selected range.

Reverse Cycle - The order of the cels is reversed so that the last cel of the actor is shown in
the first frame of the selected range. The cel numbers decrease as the frame numbers 
increase. The sequence is repeated over the selected range of frames.

Ping Pong - The original order of the cels is used, then the order is reversed. For example, if
you have four cels, the order would be 1, 2, 3, 4, 3, 2, 1, 2, 3, 4, 3, 2 ..., over the selected 
range of frames.

Slow Forward - The cels are shown in the original forward order; however, the same cel is 
repeated over two consecutive frames, e.g., 1,1,2,2,3,3,...in the selected range. This has the
effect of "slowing down" the actor.

Slow Reverse - The cels are shown in the reverse order with the same cel repeated over 
two consecutive frames, e.g., 4,4,3,3,2,2... in the selected range. This has the effect of both 
"slowing down" the actor, and running it in reverse.

Random - The order in which the cels are displayed within the selected range is generated 
randomly.



Setting Cel Size

To set the size of a single cel or cel sequence:
1. Select an actor.
2. Open the Cel Sequencer.
3. Change the size of the first cel of a cel sequence by double-clicking on the existing cel 

Size% and then entering the desired size. If you are setting the size of a single cel, 
then your task is complete.

4. With the first cel still selected, choose the range of cels by holding down the Shift key 
and then clicking on another cel. Use the frame slider control if necessary to locate the
second cel to click on. If you want to select all frames, click on the Sequence Sizing 
Options flyout and then choose Select All. 

5. Choose the Constant effect from the Sequence Sizing Options flyout. The size of the 
cels will be set to that of the first cel in the selected range .



Full Size - Selected cels are displayed at their normal (100%) size. 

Small to Large - The first cel in the selected range is displayed at 1% of normal size and is 
increased until the size reaches 200% at the end of the range. All cels displayed outside of 
the selected range of frames are shown at 100%.

Large to Small - Cel size starts at 200% of normal and reduces in size until the last cel in 
the selected frame range reaches 1% of normal size. All cels displayed outside of the 
selected range of frames are shown at 100%.

Normal to Large - Cel size starts at 100% of full size in the selected frame range and 
increases to 200%. All cels displayed outside of the selected range of frames are shown at 
100%.

Large to Normal - Cel size starts at 200% in the selected frame range and decreases until 
it reaches 100%. All cels displayed outside of the selected range of frames are shown at 
100%.

Small to Normal - Cel size starts at 1% of full size in the selected frame range and 
increases to 100%. All cels displayed outside of the selected range of frames are shown at 
100%.

Normal to Small - Cel size starts at 100% of full size in the selected frame range and 
decreases to 1%. All cels displayed outside of the selected range of frames are shown at 
100%.

Constant - Selected cels are displayed the same size as that of the first cel of the selected 
frame range.

Random - The cels are shown at various sizes from 1% to 200% in no particular order. All 
cels displayed outside of the selected range of frames are shown at 100%.



Setting Cel Size Ranges
To vary the size of a cel sequence over a range of frames:

1. Select an actor.
2. Open the Cel Sequencer.
3. Select the first cel of a cel sequence by clicking on the existing cel Size%.
4. With the first cel still selected, choose the range of cels by holding down the Shift key 

and then clicking on another cel. Use the frame slider control if necessary to locate the
second cel to click on. If you want to select all frames, click on the Sequence Sizing 
Options flyout and then choose Select All. 

5. Choose an effect from the Sequence Sizing Options flyout.



Installing the CorelMOVE MCI Player Driver
To install the CorelMOVE MCI Player onto a CorelDRAW system:

1. Run the CorelDRAW install program
2. Choose Custom Install and follow the onscreen instructions.

To install the CorelMOVE MCI Player Driver onto a NON-CorelDRAW user system.
1. On a CorelDRAW user system copy to a floppy, the files \corel50\move\oemsetup.inf and \
corel50\programs\mcicmv50.drv.

2. On the NON-CorelDRAW user system, go into the Control Panel and select Drivers
3. Select Add
4. Select "Unlisted or updated driver"
5. Select the floppy drive and select "CorelMOVE Player"

Using the media player, you should now be able to play any .cmv or .mwf file on NON-
CorelDRAW user system.



























Mosaic Roll-Up
Corel MOSAIC, a file management application, appears as a roll-up window in the Corel 
application you are currently using.    The Mosaic roll-up is used to display a collection of 
thumbnails, each thumbnail representing a file. You can use drag and drop to open or import
files displayed in the roll-up, in the application you are working with.

Two Mosaic roll-up windows can be opened at the same time in an application, allowing you 
to move or copy files between collections using drag and drop. 

Control menu box    
Use to roll up, roll down, close the Mosaic roll-up window, arrange all opened roll-up 
windows or close them all.

Directory drop-down list 
Located immediately below the Control menu box, the directory drop-down list allows
you to select or change the directory, library or catalog displayed in the Mosaic Roll-
Up. A file folder icon precedes each directory name in the list, a book icon precedes 
catalog names and a book collection precedes library names.    An open collection, of 
any type, has an open file folder preceding its name.

Open collection button     
Allows you to select or change the directory, library or catalog displayed in the 
Mosaic Roll-Up.    It displays the Open Collection dialog box where you choose the 
type of collection you wish to open; directory, library (.CLB) or catalog (.CLC).    To 
open a directory, select the file type you want to see, All Image Files to see 
thumbnails of all graphic files or All Files to see thumbnails of all files in the 
directory.

The Options button displays additional options to sort files, see notes associated and
keywords associated with them and a Find button to find files that have specific 
keywords.    The keyword options are not available in every Corel application.

Thumbnail size and orientation
The thumbnail size, orientation and other settings used in the collection are the ones 
saved when the standalone mode of Corel MOSAIC was last used.

Drag and Drop to the application
You can import a file into the application by clicking its thumbnail    and dragging it to 
the current document in the application. Files of any files formats supported by the 
Corel application can be imported.

Moving and copying files between collections
You can copy a file to a different collection by clicking its thumbnail and dragging it to
the collection of your choice. Holding down the Shift key while dragging the file 
moves it instead of copying it.



Catalog
A collection type in which thumbnails of your files, along with keywords and pointers indicating the 
location of your files are stored. A catalog does not contain the actual files. It is used to visually group files
that are saved in different directories yet are of related subject matter. 



Collection
A general term referring to master files which contain thumbnails.    The thumbnails are 
associated with files and are displayed in a single window in the display screen.    A collection
can be a library, a catalog or a directory. 

A library contains the actual files it shows as thumbnails in a compressed format.    A 
directory contains the files in an uncompressed format. A catalog contains only references 
pointing to files located in various directories and keywords associated them. 



Batch Operations
A task performed on several consecutive graphic files.    Batch printing, importing, 
exporting/converting and extract/merge-back text are available in Corel MOSAIC 
(standalone).



Library
A type of collection in which individual graphics files are stored in a compressed format.



Thumbnails
Small bitmapped representations of graphic files created and saved with original drawing files. 
Thumbnails are used within Corel MOSAIC as a way of organizing, displaying, and selecting graphics 
files visually rather than by filename. 



Corel MOSAIC
A versatile file management utility included with CorelDRAW 5. Corel MOSAIC works in one of
two modes; standalone or roll-up.    The standalone mode, accessed by double-clicking the 
Corel MOSAIC icon in the Corel Applications group, provides full functionality.    It allows you 
to create collections, perform batch operations to graphics files, export files, to name just 
few.    

The roll-up mode displays MOSAIC as a roll-up window within another CorelDRAW 
application. It provides basic functionality by giving you quick access to graphic files and 
allows you to use drag and drop to import or open files within the application.



Using the Mosaic Roll-Up
Opening collections
Resizing the Mosaic roll-up window
Importing files using drag and drop
Moving/copying files between collections



Opening collections
The Mosaic Roll-Up command allows you to open collections of thumbnails of graphic files.    
The thumbnail representation of the files makes it easy and fast to select and manage your 
graphic files.

You can have two Mosaic roll-up windows displayed in any Corel application.    This is useful 
when you need to import files from different collections or move/copy files between 
collections.

To choose a collection:
1. Choose Mosaic Roll-Up in the File menu.    The Mosaic roll-up window appears and displays 

thumbnails of a directory's files. 

2. Click . The Open Collection dialog box appears.

3. In the Open Collection dialog box, choose a file type in the List Files of Type drop-down list box 
from one of the following:

· .CLC to open a catalog file 

· .CLB to open a library file

·    another file format in the list to open a directory; only the files of the chosen format appear.

· All Files or All Image files to display files of any format/any graphic format, included in the 
selected directory.

4. The thumbnails of the graphic files included in the collection appear in the roll-up window. Files 
saved in a file format not supported by Mosaic are listed but a large "X" appears instead of a 
thumbnail.

5. Repeat steps 1-3 to open a second collection.



Resizing the Mosaic roll-up
You may want o resize the roll-up in order to see more thumbnails at one time.

To resize the Mosaic roll-up window:
1. Position the cursor over the horizontal or vertical window border of the Mosaic roll-up window.    

The cursor changes to a double arrow indicating both directions in which you can move the 
border.    

2. Click and drag the window border until the window is of the desired size.    If you drag the window 
border from a corner, the double arrow is diagonal and allows you to resize the roll-up window 
horizontally and vertically at the same time.



Opening image files using drag and drop
The Mosaic roll-up makes it very easy to open graphic files in Corel applications with the use 
of drag and drop.

To import files in a Corel application using the Mosaic roll-up:
1. In a Corel application, choose Mosaic Roll-Up in the File menu.

2. If needed, change the current collection by choosing one in the directory drop-down list.

3. Click the thumbnail of the file you want to open. The thumbnail is highlighted.

5. Press and hold down the mouse button, drag the cursor to the application window and drop it by 
releasing the mouse button.

6. The file associated with the thumbnail appears in the image area and is ready for tracing. 



Moving and copying files using drag and drop
You can open two Mosaic roll-up windows in a given Corel application.    Using drag and drop, 
you can copy or move files between collections displayed in the roll-up windows.

To copy or move files using drag and drop:
1. In a Corel application, choose Mosaic Roll-Up in the File menu.

2. Choose a collection.

3. Repeat steps 1 and 2 to open a second collection.

4. Click the thumbnail of the file you want to move or copy. The thumbnail is highlighted. Press the 
Ctrl key and click to select multiple thumbnails.

5. Press and hold down the mouse button, drag the cursor to the other Mosaic roll-up and drop it by 
releasing the mouse button to copy the file.    Press the Shift key before releasing the mouse 
button to move the file.

6. A dialog box appears asking you to confirm the move or copy operation.



Open Collection (File menu)
Opens an existing collection (catalog, library or directory) containing graphic files for viewing in the roll-
up window.

The command displays thumbnails of the graphics files included in the collection in the file 
display screen. If a file is not a graphic file, but is a file type recognized by Corel MOSAIC, the
icon representing the program it was created in is displayed.

indicates that the file is in a format that Corel MOSAIC does not recognize. If 
CorelDRAW supports the format, you can still import, export and print the file.
You can search for specific files by keywords and choose the order (by name or date) the images will be 
displayed in.

Several collections can be opened at the same time in Corel MOSAIC, allowing you to move or copy files 
between them using drag and drop.

Dialog Box Options

File Name
Displays the files of the selected file type contained in the current directory.    It also lists all 
catalogs or libraries in the current directory. Double-click a collection name and all thumbnails for 
the files within the collection display in the display screen.

Directories
Displays a list of directories for selecting catalogs, libraries and directories. Double-click on a 
directory to display the related sub directories and to list all file names of a given format in the 
File Name box. 

List Files of Type
Displays the file formats available for selection, which include Catalog File(.CLC), Library 
File(.CLB),and supported file formats for all the CorelDRAW applications. When opening a 
directory, choose a specific file type to have only files of that type display in the display screen.    
All Files displays all files included in a directory and All Image Files displays only files of a 
graphic nature.

Drives
Lists the drives available for selection.

Preview
When enabled, shows a thumbnail image of the graphics file highlighted in the File 
Name box.

Options >>
Displays additional options for searching and sorting files.

Tip
When viewing a collection containing many files, clicking the window as the files are 
being loaded halts the display. When ready to continue, pressing the ESC key 
resumes the display.





Open Collection Options (File menu)
The following options appear when the Options >> button is clicked in the Open Collection 
dialog box.    Their purpose is to search a collection for files that contain specific keywords 
and display their thumbnail images in the display screen. The keywords are saved with the 
original file, in the application used to create it. CorelDRAW and CorelSHOW support the use of 
keywords.

Dialog Box Options
Sort by Options for sorting files by their file name or date. Both the files listed in the dialog 

box and the thumbnails in the display screen are sorted according to the chosen 
Sort by option.

Subdirectories When selected, Corel MOSAIC searches the current directory and all subdirectories 
below it for graphics files of a specified file format. 

Keywords Displays the indexing terms associated with the selected file. 

Notes Displays the annotations associated with the selected file.

Fonts Displays the names of the fonts used in a selected file.

Find Searches a directory for Corel files that contain specific keywords and displays their 
thumbnail images in the display screen. 

Tip
When viewing a collection containing many files, clicking the window as the files are 
being loaded halts the display. When ready to continue, pressing the ESC key 
resumes the display.
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Advanced Calibration features
The Color Manager is a powerful tool. Its basic features, namely the configuration of two (or 
three) devices into a System Profile, will be easily and quickly mastered by all users. The 
advanced calibration features, however, are intended to be used by informed users only. A 
solid understanding of color and calibration is essential for successful use of these features.

The System Color Profile dialog box leads to a series of further dialog boxes. 

Before using the advanced calibration features, you may want to review: Working with basic 
System Profiles



Accessing the advanced features
You access the advanced features for all devices, whether monitor, printer or scanner, in one
of two ways: by choosing "Other" from the device list, or by clicking the Edit button.
To access the advanced features:

Do one of the following:
· Other:  If your device is not listed in the System Color Profile dialog box, choose Other 

from the device list. This will give you access to the calibration dialog box for that type 
of device.

· Edit:    If your device is listed but you want to review or modify the default settings 
offered by the Color Manager, click Edit to access the calibration dialog box for that 
particular device.



Calibrating your monitor numerically
Monitor calibration can be done numerically or interactively.
To calibrate your monitor numerically:

1. In the Monitor Calibration dialog box, enter the monitor characteristics for Red, Green 
and Blue. For each of the three colors, you must specify the gamma as well as the 
chromaticity (x, y). These values can be supplied by the monitor manufacturer.

2. Enter a white point temperature in degrees Kelvin.
Click Reset to return to the default values if need be.

3. Choose OK.
Note: If you chose Other from the monitor list, a text entry field at the top of the Monitor 
Calibration dialog box allows you to enter a name for the monitor. This name is added to the 
monitor list for future recall.



Calibrating your monitor numerically
Monitor calibration can be done numerically or interactively.
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2. Enter a white point temperature in degrees Kelvin.
Click Reset to return to the default values if need be.
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Note: If you chose Other from the monitor list, a text entry field at the top of the Monitor 
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Calibrating your monitor interactively
Monitor calibration can be done interactively or numerically.
To calibrate your monitor interactively:

1. In the Monitor Calibration dialog box, click Interactive.
The Interactive Monitor Calibration dialog box appears.

CAUTION: The gamma and white point must definitely be adjusted, as they differ from 
monitor to monitor, even within a given brand. The chromaticity values, however, 
SHOULD NOT be adjusted, for the reasons listed in step 4.
2. Do one of the following:

· Adjust the gamma for each color channel in turn (Red, Green and Blue) by scrolling 
up or down until both sides of the color box appear the same.

· Adjust the color gamma for one channel then enable Identical to set an identical 
gamma for all three channels.

Click Preview to evaluate the effect of your adjustments.
3. Use the slider bar to specify a cooler or warmer white point. The value in degrees 

Kelvin is displayed to the right of the slider bar. 
Click Preview to evaluate the effect of your adjustments.

4. It is strongly recommended that default chromaticity values be left as is, for a number 
of reasons: chromaticity values are stable and almost identical from monitor to 
monitor; the default values    are correct; visual adjustments are difficult to discern and 
evaluate.
If you must, you can adjust the chromaticity by dragging the Red, Green and Blue 
markers to achieve the desired result. The x and y values are displayed below the color
boxes. Note that the effect of your adjustments will be difficult to evaluate in the 
Preview.
Click Reset to return to the default values if need be.

5. Choose OK.
Note: If you chose Other from the monitor list, a text entry field at the top of the Monitor 
Calibration dialog box allows you to enter a name for the monitor. This name is added to the 
monitor list for future recall.
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Calibrating your printer:    general notes
When it comes to your printer, two separate operations must be performed:
· calibration
· characterization
Calibration
The printer calibration process varies depending on whether the device employs a CMYK or 
RGB color model.
Characterization
The printer characterization process is the same for both color models. Use either a Color 
Match file or the visual method to perform the characterization.
Spectrophotometer / colorimeter settings:
When characterizing your printer, you may choose from the supplied files or generate your 
own. To generate your own IM, GRY or RNH files, you will need a spectrophotometer or a 
colorimeter. The measurement device should be set up as follows:
· Set the White Base to abs and calibrate it with the manufacturer-supplied white.
· Set the Illumination Type to D65.
· Set the Eye Angle to 2 degrees.
· Set the Filter to None (do not use D65 or Pol).



 
Calibrating your CMYK printer

1. In the Printer Calibration dialog box, choose CMYK as printer type.
2. Choose Print if outputting directly to paper. Choose Film if the output device is an 

imagesetter.
3. Enter a percentage for Total Area Coverage (TAC). This refers to the maximum 

allowable quantity of ink (i.e., total combined amount of C, M, Y and K inks).
4. Adjust the K curve in the CMYK Plates box. Click Reset to return to the default values if 

need be.
5. A default dot gain is provided. It is appropriate for most jobs. Verify with your printing 

shop before changing this value.
Note: CorelDRAW ships with some ready-made ink models.    An .IM file to match or 
approximate your printer may be available. Check the list.    If an appropriate .IM file exists, 
you need not perform steps 6 and 7    just continue at step 8.

6. Click Print CMYK Patterns. The Print dialog box appears. Choose a printer. The CMYK320
color pattern file is printed to the chosen printer.

7. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of each color 
square in numerical sequence (from 1 to 320). Enter the measurements in an ASCII file 
with three columns: X, Y and Z (with a space separating the columns).. Name the file to
reflect the printer and give it a .IM extension    for example, TEK300I.IM for data 
measured from the printout of a Tektronix 300I. Copy the file into the COREL50\COLOR 
subdirectory. Return to the Printer Calibration dialog box. 

8. Choose the appropriate .IM file .
9. Click Calculate.
10. The Color Match option becomes available. Click the button. The Printer 

Characterization dialog box appears. Establish printer characterization according to 
one of the two methods described under: 
Characterizing your printer using a Color Match file
Characterizing your printer using the visual method
When you return to the Printer Calibration dialog box after characterizing the printer, 
choose OK.

Note: If you chose Other from the printer list, a text entry field at the top of the Printer 
Calibration dialog box allows you to enter a name for the printer. This name is added to the 
printer list for future recall.



 
Calibrating your RGB printer

1. In the Printer Calibration dialog box, choose RGB as printer type.
2. Click Print RGB Patterns.    The Print dialog box appears. Choose a printer. The RGB80 

color pattern file is printed to the chosen printer.
3. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of the 

grayscale squares only, in numerical sequence (from 65 to 80). Enter the 
measurements in an ASCII file with three columns: X, Y and Z (with a space separating 
the columns). Name the file to reflect the printer and give it a .GRY extension    for 
example, CJ10.GRY for data measured from the printout of a Canon CJ10. Copy the file 
into the COREL50\COLOR subdirectory. Return to the Printer Calibration dialog box. 

4. Choose the .GRY file you have created.
5. Click Color Match. The Printer Characterization dialog box appears. Establish printer 

characterization according to one of the two methods described under: 
Characterizing your printer using a Color Match file
Characterizing your printer using the visual method
When you return to the Printer Calibration dialog box after characterizing the printer, 
choose OK.

Note: If you chose Other from the printer list, a text entry field at the top of the Printer 
Calibration dialog box allows you to enter a name for the printer. This name is added to the 
printer list for future recall.



 
Characterizing your printer using a Color Match file
Printer characterization can be performed using a Color Match file or using the visual 
method.
To perform characterization using a Color Match file:

1. In the Printer Characterization dialog box, choose File.
2. Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
3. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of each color 

square in numerical sequence (from 1 to 80). Enter the measurements in an ASCII file 
with three columns: X, Y and Z (with a space separating the columns). Name the file to 
reflect the printer and give it a .RHN extension    for example, TEK300I.RHN for data 
measured from the printout of a Tektronix 300I. Copy the file into the COREL50\COLOR 
subdirectory.

4. Return to the Printer Characterization dialog box. Choose the .RHN file you have 
created.

5.Choose OK.



Characterizing your printer using a Color Match file
Printer characterization can be performed using a Color Match file or using the visual 
method.
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with three columns: X, Y and Z (with a space separating the columns). Name the file to 
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created.

5.Choose OK.



 
Characterizing your printer using the visual method
Printer characterization can be performed visually or using a Color Match file.
To perform characterization using the visual method:

1. You must calibrate your monitor before proceeding if the visual characterization of your
printer is to be meaningful. Click Calibrate Monitor. If a Monitor calibration circuit is in 
place, it will be used. Otherwise, a dialog box will appear to allow you to calibrate your 
monitor.

2. In the Printer Characterization dialog box, choose Visual.
3.Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
4.Adjust the colors interactively or by entering numeric values so that they approximate 

the test printout. Adjustments follow the norms of the HSB (Hue, Saturation, 
Brightness) model.
If you are not pleased with the changes you have made to a color, click Reset Color to 
start fresh.

5.Choose OK.



Characterizing your printer using the visual method
Printer characterization can be performed visually or using a Color Match file.
To perform characterization using the visual method:

1. You must calibrate your monitor before proceeding if the visual characterization of your
printer is to be meaningful. Click Calibrate Monitor. If a Monitor calibration circuit is in 
place, it will be used. Otherwise, a dialog box will appear to allow you to calibrate your 
monitor.

2. In the Printer Characterization dialog box, choose Visual.
3.Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
4.Adjust the colors interactively or by entering numeric values so that they approximate 

the test printout. Adjustments follow the norms of the HSB (Hue, Saturation, 
Brightness) model.
If you are not pleased with the changes you have made to a color, click Reset Color to 
start fresh.

5.Choose OK.



 
Calibrating your scanner from a file
Scanner calibration can be done from a file or from an image.
To calibrate your scanner from a file:

1. In the Scanner Calibration dialog box, choose File.
2. Choose a file from the list of available scanner calibration files (.SCN).

If there is no file for your scanner, you can easily create one. See Calibrating your 
scanner from an image.

3. Choose OK.
Note: If you chose Other from the scanner list, a text entry field at the top of the Scanner 
Calibration dialog box allows you to enter a name for the scanner. This name is added to the 
scanner list for future recall.



Calibrating your scanner from a file
Scanner calibration can be done from a file or from an image.
To calibrate your scanner from a file:

1. In the Scanner Calibration dialog box, choose File.
2. Choose a file from the list of available scanner calibration files (.SCN).

If there is no file for your scanner, you can easily create one. See Calibrating your 
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Calibrating your scanner from an image
Scanner calibration can be done from an image or from a file.
To calibrate your scanner from an image:

1. Scan the calibration target provided by Corel, or an IT8 target if you have one. It is 
important that you scan in raw data. If you are scanning from Corel PHOTO-PAINT, 
disable the Scanner Calibration option in the Preferences dialog box. Save the scan as 
a TIFF file.

2. In the Scanner Calibration dialog box, choose Image.
3. Choose the scanned target (.TIF) file you have created. If necessary, click Browse to 

find the file.
4. Choose a reference file. If necessary, click Browse to find the file. Corel provides a 

reference file, but you may opt to use your own, such as a proprietary IT8 reference 
file. It must bear a .REF extension.

5. Click Scanned Target. The Scanned Target dialog box appears.
6. Drag each of the four corner markers such that they frame the entire color grid. Note 

that each corner of the grid is marked by a fiducial mark for your convenience.
The Color Manager will compare the values of the colors thus framed to the values in 
the reference file and perform color calibration accordingly.

7. Choose OK. The Save Scanner File dialog box appears.
8. Enter a name and choose OK. A scanner calibration file with the extension .SCN is 

created.
If you chose Other from the scanner list, a text entry field at the top of the Scanner 

Calibration dialog box allows you to enter a name for the scanner. This name is added to the 
scanner list for future recall.



Calibrating your scanner from an image
Scanner calibration can be done from an image or from a file.
To calibrate your scanner from an image:

1. Scan the calibration target provided by Corel, or an IT8 target if you have one. It is 
important that you scan in raw data. If you are scanning from Corel PHOTO-PAINT, 
disable the Scanner Calibration option in the Preferences dialog box. Save the scan as 
a TIFF file.
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4. Choose a reference file. If necessary, click Browse to find the file. Corel provides a 

reference file, but you may opt to use your own, such as a proprietary IT8 reference 
file. It must bear a .REF extension.

5. Click Scanned Target. The Scanned Target dialog box appears.
6. Drag each of the four corner markers such that they frame the entire color grid. Note 

that each corner of the grid is marked by a fiducial mark for your convenience.
The Color Manager will compare the values of the colors thus framed to the values in 
the reference file and perform color calibration accordingly.

7. Choose OK. The Save Scanner File dialog box appears.
8. Enter a name and choose OK. A scanner calibration file with the extension .SCN is 

created.
If you chose Other from the scanner list, a text entry field at the top of the Scanner 

Calibration dialog box allows you to enter a name for the scanner. This name is added to the 
scanner list for future recall.



Working with basic System Profiles
A color management system must take into account all factors involved for all the devices 
used for color acquisition, viewing and reproduction. This is done by building a System 
Profile. A System Profile indicates which monitor and printer are part of your publishing 
system. It may also include a scanner if you are working with Corel PHOTO-PAINT.

If any component of your system changes, you must make this change known to the Color 
Manager by updating your System Profile. Similarly, if you have access to multiple devices, 
you will need to build a System Profile for each combination of two (or three) devices that 
you use. 
Once built, simply select and enable the appropriate System Profile according to the devices 
your project currently calls for.
For step-by-step instructions, see:
Basic
Creating a basic System Profile
Selecting a System Profile

Advanced
Advanced calibration features



 
Creating a basic System Profile
All you need to know about your system is the brand name and model number of each 
device. The Color Manager has built-in information sheets for a large number of devices and 
chances are yours will be in the lists. You do not need to know the technical properties of 
your devices; just pick their names from the lists and save the configuration as a System 
Profile.
To create a basic System Profile:

1. Choose Color Manager from the File menu.
The System Color Profile dialog box appears.

2. Choose a monitor.
3. Choose a printer.
4. Choose a scanner (optional). This can only be done from an application that support 

scanners, such as Corel PHOTO-PAINT.
5. Enter descriptive comments in the Notes box to help you better manage your System 

Profiles (optional).
6. Click Generate. 

The Generate Profile dialog box appears.
7. Enter a name for the System Profile.
8. Click OK. System Profile generation will take a few minutes.
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Selecting an existing System Profile
Your work may entail working with a number of various devices of each type. You may 
therefore need to load a different System Profile depending on the task at hand. System 
Profiles can be created as explained under Creating a basic System Profile. Once created, 
selecting one is easy.
To select an existing System Profile:

1. Choose Color Manager from the File menu.
The System Color Profile dialog box appears.

2. From the Current Profile list, choose a System Profile.
3. Click Select.
Note: By default, AutoMatch is enabled, ensuring that automatic color matching is 
performed. This is the normal way to proceed and the default should be left as is, unless you
want to force a different color matching method.

If you are working in CorelDRAW, AutoMatching means the Color Manager will automatically 
differentiate between bitmapped and vector objects, and optimize each type of object 
accordingly. In Corel PHOTO-PAINT, AutoMatching means that the System Profile is optimized
for bitmaps. Another application may be optimized for line art.

You can force the Color Manager to optimize the color matching for line art by enabling 
Illustration. Similarly, if you want to force the Color Manager to optimize the color matching 
for bitmaps, enable Photographic.



System Color Profile dialog box
The System Color Profile dialog box allows you to create a system color profile to help Corel 
PHOTO-PAINT capture, display and print color across different devices more accurately.

Dialog Box Options

Current Profile
Displays the name of the current color profile. If you have different printers, you may 
wish to build different color profiles and then select the appropriate one before 
working on images for that output device.

Notes
Allows you to attach notes to your system profile. Useful for keeping track of different
equipment setups.

Monitor
Displays monitor choices. .

Printer
Displays printer choices. 

Scanner
Displays scanner choices. .

Automatch
Enables the two different color gamut mapping systems, Illustration and 
Photographic. Corel PHOTO-PAINT automatically senses whether it is printing a vector
or bitmapped object and applies the appropriate gamut map.

Photographic
Enables the Photographic color mapping only. Use to force Photographic color 
mapping regardless of object type.

Illustration
Enables Colorimetric color mapping for working with spot colors. Use to force 
colorimetric color mapping regardless of object type.
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Monitor Calibration
Allows you to calibrate your monitor to enhance color accuracy.

Dialog Box Options
Monitor Defines the monitor gamma settings. As you
Characteristics: increase the gamma level you are increasing the brightness of your 

midtone gray levels. Chromaticity defines hue and saturation or 
chroma. It's important to use the manufacturer recommended levels of 
chromaticity for your monitor. If you do not have manufacturer 
recommended levels and wish to modify gamma or chromaticity settings
use Interactive Monitor Calibration.

White Point Defines the color temperature of your monitor in creating white.
Reset Returns the gamma and chromaticity values to default.

Interactive Interactive calibration lets you adjust 
 Calibration gamma, white point and chromaticity interactively. Adjust the color fields to 

enhance color accuracy. Chromaticity should be set to the manufacturer's 
specifications. Gamma or brightness is variable according to the level of light in the
room and the brightness and contrast controls on your monitor. White point 
temperature for an individual monitor will have a factory default but monitors can 
vary from their default. 



Printer Calibration
Allows you to calibrate your printer to enhance color accuracy.

Dialog Box Options
Printer Type Defines whether the printer prints using four colors (CMYK) or three 

(RGB).

UCR Choose Film or Printer, depending on the output device you are 
configuring. TAC (Total Ink Coverage) adjusts the level of UCR. See 
your printer for the appropriate level of UCR. It depends on paper 
stock and the printer used.

Dot Gain Halftone dots that make up an image gain in size from the time you 
view them on film to the time they come off the press. This 
unavoidable increase in size results in colors that appear more 
intense in the printed image than intended. 

Dot Gain is calculated two ways: 

The default Dot Gain is calculated by the ink model. This gives you an
average value and is set automatically by Color Manager. This is the 
recommended level of dot gain.

If you need to reset Dot Gain for a specific job you can set a constant 
dot gain level. Consult with your printer before changing this setting.

Ink model field Defines the ink model for the selected printer.

Color Match Allows you to match your printer and monitor color accuracy.

Print CMYK Patterns... Allows you to generate a test file to be measured to create a 
new Ink Model.

Calculate Updates the calibration changes you have made before you continue 
on to Color Match.

Reset Returns the black point value to default.

OK Accepts the changes you have made.

Cancel Abandons the changes you have made.

Printer Characterization
Characterization establishes a normalized color relationship between your device and
the CIE based reference Color System. This characterization may be based on 
spectrophotometric measurements (File) or visual methods (Visual).

Visual
Print Testing Print these patterns to match 
Patterns against the view field in the Printer Characterization dialog box.
Calibrate Monitor If you have not already done so, calibrate your monitor before continuing with 

your Color Match.
Reset Returns Hue, Saturation and Brightness to the default values.



OK Accepts the changes you have made.
Cancel Abandons the changes you have made.

File
Print Testing Print these patterns and measure
Patterns the CIE X Y Z values in order to create a new RHN file.
File Name Choose an existing RHN that matches your output device or choose a new 

RHN that you have built.



Scanner Calibration
Allows you to calibrate the color accuracy of the systems scanner.

Dialog Box Options
Scanned Target 

File: Allows you to choose a pretested scanner setting. 
Image: Allows you to build a specific named scanner profile based on the 

characteristics of your printer.

Scanned target: Your scan of the Corel Scanned Target reference card included with Corel 
PHOTO-PAINT. 

Reference file: This reference file is included with Corel PHOTO-PAINT. Color Manager 
compares this file against your scanned target to create a scanner 
profile.

Scanned target: Allows you to adjust for any skew or misalignment of your scan of the 
target. This ensures that the scanner profile compares the same areas of
both the reference file and your scanned target.

Shortcut
Pressing ALT+F,C opens the System Color Profile dialog box.



Using CorelMOVE Online Help
Using secondary windows
How to use Context-sensitive Help
Opening other programs' Help files
Keeping Help on top
Using Help's Search feature
Using the History button
Using speed keys



How to use Context-sensitive Help
The CorelDRAW 5.0 suite of programs features the range of Context-sensitive Help indicated 
below:

Context-sensitive Help pointer: Choose Screen/Menu Help from the Help menu 
and click the menu item, tool, button, or interface item you want information about. 
Keyboard: Shift+F1

F1: Press F1 while you have any dialog box open--a Help topic specific to the dialog box 
will appear.

Help menu: Choose a Help item from the Help menu.



Using the History button
The History button, which lists the last 50 Help topics viewed, provides a useful alternative 
to the Contents buttons.

To use the History button:

1. Press "h" on the keyboard, or click the History button and scroll through the topics until 
you find the one you are interested in.

2. Click the topic you want to review and close the History window.

3. When you close the History window, the list of last topics viewed remains in memory.



Opening other programs' Help files
You can open Online Help files for other Microsoft Windows-compatible programs using the 
Help File Menu. The example below explains how to open Online Help for CorelDRAW!

To open CorelDRAW's Online Help:

1. Choose Open from the CorelMOVE Help Menu Bar. 

2. Double click Coreldrw.hlp from the File Name box.

Note: You can open any of the Online Help files for the CorelDRAW suite of applications 
from the Programs subdirectory by double-clicking them in the main directory 
where you installed CorelDRAW, usually \COREL50\PROGRAMS. 



Using Help's Search feature
Help Search keywords are usually limited to specific topic names or subjects. If the topic is 
procedural, the keyword describing it will take you to a Contents section. From there choose 
the topic you are looking for.

In general, try to use the terms used by CorelMOVE, beginning with subject area in searching
for help about dialog boxes, menu items or subject areas. In the example below, using the 
key words "Setting up spreadsheets" would not bring up the desired topics. 

To search for information about formatting spreadsheets:

1. With a Help window active, press "s" or click the Search Help button.

2. Type "spr" in the Search box. A list of topics appears in the Show Topics area of the 
Search dialog box, including "spreadsheet." 

3. Press enter with the term "spreadsheet" highlighted in the Show Topics box. The topic 
"Format your spreadsheets" appears in the Go To area of the dialog box.

4. Double-click "Format your spreadsheets." The list of topics for that area appears for you 
to choose from.



Keeping Help on top
By default, Online Help windows remain open but drop out of sight when you activate 
another window. Sometimes, however, you may find it useful to keep Help windows visible 
while you work---the smaller secondary windows containing procedures are particularly 
useful this way. (Application menus will still appear on top of your Help window when called 
using speed keys.)

To keep a Help window on top:

1. Click the Help from Help Menu Bar in any main Help window.

2. Choose Always on Top.

This causes both main and secondary windows to remain on top. Resize as required.

Notes: You may toggle the On Top command on and off, and minimize on-top Help 
windows to icons. 



Using secondary windows
Secondary Online Help windows, the smaller windows that appear when you click a 
procedural topic title in a Help contents listing, display concise step-by-step Help 
information. Secondary windows are useful because they cover a smaller portion of the 
active application window than main Help windows. And because they stay on top, 
secondary windows make it easier to carry out a procedure and view its Help topic at the 
same time without switching back and forth between windows.

Always on top: CorelMOVE's secondary Help windows differ from main Help windows in 
that they are programmed to remain on top of your current application window until you 
need to close or minimize them. 

The following limitations apply to secondary windows:

Search: Help topics shown in secondary windows cannot be coded for search keywords. If 
you use Help's Search function for a topic in a secondary window, Help takes you to a main 
menu which will include the topics you are looking for.

Sizing: Unlike other window types in the Windows Operating System, secondary windows do
not "remember" when you change their default size and position. 

To resize a secondary window and retain that size for subsequent topics viewed during the 
current CorelMOVE session, minimize the window rather than closing it when finished. The 
next time you open a topic held in a secondary window it will appear in the size and location 
you set for the minimized window.

The Buttons: Secondary window buttons cannot at this time be programmed for underlined
characters which "press the button" when you press the underlined letter on the keyboard; 
they must be clicked with the mouse pointer. Secondary windows also cannot include 
browse buttons.



Using speed keys
Speed keys, also known as hot keys, are keys that when pressed in combination execute 
menu commands. Some people prefer to use speed keys rather than reach away from the 
keyboard for the mouse and click two or more menu items or a tool button. 

To carry out a command using combination speed keys such as Ctrl+Tab:

1. Press and hold down the first key, e.g., Ctrl.
2. Press and release the second key, e.g., Tab.
3. Release the Ctrl key.



System Info dialog box
Use System Info to display information about your system, display, network, printing, Corel 
EXEs & dlls and system DLLs.

Dialog Box Options

Choose a category Choose a category from the drop-down list box. The categories are: 
System, Display, network, printing, Corel EXEs and DLLs and 
system DLLs.

List box Displays the system information for the chosen category.
System: information about your computer. For example, Windows 
version, DOS version, processor, etcetera.
Display: information about your monitor. For example, driver, driver
version, etcetera.
Network: information about the network. For example, drivers, 
whether a network is installed, etcetera.
Printing: information about installed printers.
Corel EXEs and DLLs: lists all of the Corel EXEs and DLLs.
System DLLs: lists all of the system DLLs.

Save Saves all of the selected category's details to a predefined file.




